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Micro Focus Enterprise Developer 2.2 for
Eclipse Release Notes
These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.
Note: This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link. Web
sites by their nature can change very rapidly and although we try to keep our links up-to-date, we
cannot guarantee that they will always work as expected.
Enterprise Developer is a contemporary development suite for Visual Studio or for Eclipse that allows
mainframe developers to maintain, develop and modernize mainframe applications regardless of whether
these are to be deployed back on the mainframe or onto alternative platforms.
Enterprise Developer supports IBM COBOL, IBM CICS, IBM JCL, IBM DB2, IBM z/OS file formats and
common batch utilities including SORT. This means that the core mainframe online and batch applications
can be developed and maintained under Enterprise Developer. These applications can then be deployed
back on the mainframe or migrated onto one of the Micro Focus Linux, UNIX or Windows based production
platforms.
Micro Focus offers Enterprise Developer with the following licensing options that unlock different
functionality:
Enterprise
Developer
Personal
Edition

Enterprise Developer Personal Edition is a free product, available for download. It is
suitable for anyone who wants to become familiar with the Eclipse or Visual Studio
means of editing and compiling mainframe applications under Windows.

Enterprise
Developer
Connect

Enterprise Developer Connect is for customers looking to use modern and productive
Eclipse-based tooling to develop mainframe applications directly on the mainframe.
Close integration to mainframe configuration management systems and the ability to
easily customize the Eclipse-based IDE to include mainframe based tools and
processes means developers can take full advantage of modern development tools
without having to learn new development processes.

Enterprise
Developer

Enterprise Developer is for customers looking to modernize mainframe applications
and move to an alternative platform. This option again uses either the Visual Studio or
Eclipse-based IDE and includes development and test tools for all platforms currently
supported by Micro Focus.

Enterprise
Developer for
IBM
zEnterprise

Enterprise Developer for IBM zEnterprise targets customers who look at developing
and maintaining their mainframe applications as well as modernizing them for
deployment back on the mainframe or any of the z/Enterprise partitions. This option
uses the Visual Studio or Eclipse-based IDE and includes mainframe integration to
support development on and off the mainframe and the Application Workflow Manager
for configuring the IDE. It also includes tools to support development and test on z/
Linux and AIX and x86 environments. Enterprise Developer for IBM zEnterprise
combines all the capabilities of Enterprise Developer Connect and Enterprise
Developer.
Full mainframe integration and the Application Workflow Manager are only available in
the Eclipse-based IDE.

In addition, this document contains information on workflow modelling extensions in the section Enterprise
Developer for IBM zEnterprise Workflow Modelling Extensions .
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Note:
•

•

The Enterprise Developer Personal Edition option is not available with this release.
You can use the Personal Edition option if you install the previous release, Enterprise Developer
Personal Edition 2.1 Update 1. When you start the product, follow the links in the Micro Focus
Enterprise Developer Product Licensing dialog box to activate the free product.
If you are currently using the Personal Edition variant and you want to use the full functionality of
Enterprise Developer or upgrade to Enterprise Developer for IBM zEnterprise, please contact your
Micro Focus representative and ask for a free evaluation license.

Note:
•

•

Micro Focus Enterprise Developer UNIX Components is only available with an Enterprise
Developer or Enterprise Developer for IBM zEnterprise license and is not available with an
Enterprise Developer Personal Edition license.
Mainframe Access Server is only available with an Enterprise Developer or with an Enterprise
Developer for IBM zEnterprise license and is not available with an Enterprise Developer Personal
Edition license.

Important: Application executables that were compiled using earlier Micro Focus products must be
recompiled from the sources using Enterprise Developer. For more information, read the section
Upgrading to Enterprise Developer for Eclipse in the product Help.

Installing Enterprise Developer
System Requirements
Hardware Requirements
z/Server has the following hardware requirements:
•

IBM mainframe model z9-109 or later is required for installing and using z/Server. z/Server will not
install on earlier hardware models.

Enterprise Developer has the following requirements in addition to the requirements of Eclipse. See the
Eclipse documentation for details of its requirements.
In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, it is recommended to have a minimum
of 2GB of RAM.
The disk space requirements for Windows are:
Platform

Enterprise Developer

Sentinel RMS License Manager

x86 Windows platforms

1.3GB

35MB

x64 Windows platforms

1.45GB

35MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.
The disk space requirements for Micro Focus Enterprise Developer UNIX Components are approximately:
Platform

Enterprise Developer (MB)

Sentinel RMS license server (MB)

POWER running AIX

396

26

HP IA

806

54
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Platform

Enterprise Developer (MB)

Sentinel RMS license server (MB)

System Z running Red Hat Linux

332

28

x86-64 running Red Hat Linux

358

33

SPARC running Solaris

431

31

System Z running SuSE SLES

337

28

x86-64 running SuSE SLES

363

33

Note: The installation requires extra disk space that equals the size of the product you install.

Operating Systems Supported
Note: You can produce 64-bit and 32-bit applications on 64-bit operating systems.
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
Note: This product can be installed on earlier versions of Windows but it has not been tested on
them.

Software requirements
Windows
Note: The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.
UNIX/Linux
•

•

•

The Korn shell is required for the licensing daemon. After the installation, if the licensing daemon does
not start, check and ensure the Korn shell is installed and then run the /var/
microfocuslicensing/bin/startmfcesd.sh script to start the daemon.
The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax -version at the command line.
On Red Hat 6.x, you must have the following operating system libraries installed:
All Enterprise Developer products

Additional libraries for Micro Focus Enterprise Developer UNIX
Components

glibc-*.x86_64
glibc-*.i686
libgcc-*.x86_64
libgcc-*.i686
glibc-devel-*.x86_64
glibc-devel-*.i686

Visit the Red Hat Web site for more information.
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•

Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

•

You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 32-bit Java installation or the installation terminates. For example, execute the following:
JAVA_HOME=java_install_dir
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•
•
•

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:
export PATH=$JAVA_HOME/bin:$PATH
You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.
GNOME menus and buttons have been standardized across all applications so that icons are not
displayed by default. To keep the icons and the look and feel of previous versions, enable the
menus_have_icons property with the command:
gconftool-2 --type boolean --set /desktop/gnome/interface/menus_have_icons
true

Other Requirements
Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Enterprise
Developer client and a new licensing server on the same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file. The following information specifies the third-party software required for
each feature.
Micro Focus Rumba
•

On Windows 8, in order to install Micro Focus Rumba you must have the Microsoft .NET Framework 3.5
Service Pack 1 installed.

Application server support for JVM COBOL
The following application servers are supported using the following JDKs:
Application Servers

JDK version

Containers support version

Tomcat 7.0.39

1.6.027

Servlets 2.5

JBoss 6.1

1.6.027

Servlets 2.5

WebLogic 12.1.1

1.6.027

Servlets 2.5

WebLogic 12.1.1 on AIX 6.1

1.6.0 SR10 FP1

Servlets 2.5

WebSphere 8.5

1.6.027

Servlets 2.5

WebSphere 8.5 on AIX 6.1

1.6.0 SR10 FP1

Servlets 2.5

The availability of resource adapters for these application servers differs between UNIX platforms. The
following table indicates where support is available for each platform:
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Platform

Tomcat 7.0.39

JBoss 6.1

WebLogic 12.1.1

WebSphere 8.5

Red Hat EL 5

32-bit and 64-bit

32-bit and 64-bit

32-bit and 64-bit

32-bit and 64-bit

Solaris on SPARC

32 bit

32-bit

32-bit

32-bit

HP/UX 11.31 on Intel
IA64

64 bit

64 bit

AIX 6.1

32-bit and 64-bit

32-bit and 64-bit

SUSE 11

32-bit and 64-bit

Eclipse IDE development is supported for Red Hat and Windows platforms only.

Installing Enterprise Developer for Eclipse
Downloading the Product
1. Use the download links in your Electronic Product Delivery email.
For more information follow the links for the installation instructions and the End User License
Agreement.

Product Co-Existence
•
•
•

Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same
machine.
Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.
Enterprise Server comes in the following versions:
•
•

Enterprise Server, which is the deployment server for applications built using Enterprise Developer
for Visual Studio 2010 and Enterprise Developer for Eclipse.
Enterprise Server 2012, which is the deployment server for applications built using Enterprise
Developer for Visual Studio 2012.

You can only deploy applications to the version of Enterprise Server from the associated development
product you used to build the applications. For example, if you built your application using Enterprise
Developer for Visual Studio 2012 you must deploy the target files to Enterprise Server 2012.

Installing and Licensing Micro Focus Rumba
The Enterprise Developer installer includes Micro Focus Rumba 9.0 which you can optionally install. The
license for Enterprise Developer enables you to use the mainframe components of Rumba (Rumba for
Mainframe).
Before using the Enterprise Developer installer to install or update Rumba, please note the following:
•

•

If you have the full, standalone version of Rumba installed on your machine, it is recommended that you
use the standard ways to upgrade this version to Rumba version 9.0 or later.
It is not recommended to use the Enterprise Developer 2.2 setup file to update Rumba as you may lose
your license for the full Rumba version.
If you are installing Enterprise Developer 2.2 onto a machine that does not have Rumba installed, it is
recommended that you select the Rumba option and install this with Enterprise Developer.
This installs the components you need to establish a mainframe 3270 connection (Rumba for
Mainframe) and a 30-day trial license for the full Rumba product. After the 30-day trial period completes
you will still access Rumba for Mainframe components as part of your Enterprise Developer license.

8
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•

If you are installing Enterprise Developer 2.2 as an upgrade to an existing licensed installation of
Enterprise Developer that is using an authorization code issued before Enterprise Developer 2.1
Update 1 (released in April 2013), it is recommended that you do not update the Rumba components
previously installed with the earlier version of Enterprise Developer.
If you do want to update Rumba, then select this during the 2.2 installation and then contact Micro
Focus SupportLine and ask for the Enterprise Developer 2.2 authorization code. This will replace your
existing 2.1 authorization code and will enable the updated version of Rumba.

Installing
These are the steps to install this product:
1. Run the ede_22.exe file and follow the wizard instructions to complete the installation.
A full version of Eclipse, with the Micro Focus plugins already installed, will be present in the C:\Users
\Public\Micro Focus\Product Name\eclipse directory.
Note:
•

•
•
•

If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.
Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.
We recommend that you install any updates for the .NET Framework that are available at the
Microsoft Download site.
If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Developer but you can install it if you wish.

Installing Silently on Windows
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install.
To install silently use the following command:
start /wait install-file.exe /q [parameters]
where install-file for the following products is as follows:
Enterprise Developer

ede_22.exe

To see what parameters you can use, execute the following from the command line:
install-file /help
After the installation is complete you can install the license silently by executing the following commands:
If you have access to
the Internet and an
authorization code

For 32-bit Windows environments:
start /wait "" "C:\Program Files\Common Files\SafeNet
Sentinel\Sentinel RMS License Manager\WinNT
\cesadmintool" -term activate AuthorizationCode
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For 64-bit Windows environments:
start /wait "" "C:\Program Files (x86)\Common Files
\SafeNet Sentinel\Sentinel RMS License Manager\WinNT
\cesadmintool" -term activate AuthorizationCode
If you don't have access For 32-bit Windows environments:
to the Internet but do
start /wait "" "C:\Program Files\Common Files\SafeNet
have a license string
Sentinel\Sentinel RMS License Manager\WinNT
\cesadmintool" -term install -f FileName
For 64-bit Windows environments:
start /wait "" "C:\Program Files (x86)\Common Files
\SafeNet Sentinel\Sentinel RMS License Manager\WinNT
\cesadmintool" -term install -f FileName
where FileName is a text file containing all the license strings to be used.
Directory considerations
•
•
•

You must have read and write access for every directory accessed during the installation.
You can override the default installation folder using the INSTALLDIR parameter:
If a path in a definition contains spaces, then the path must be preceded by a backslash and double
quotation mark (\"). For example:
INSTALLDIR=path
INSTALLDIR=\"c:\MyProduct\"
INSTALLDIR=\"c:\Program Files\Micro Focus\My Product\"

•

Installing creates a log file in %temp%\LogFilename by default. To change the location or name, use
the /log parameter on your Setup command line and specify the path and file name, for example:
The default names for the log files are as follows:
Micro_Focus_Enterprise_Developer_for_ for the Enterprise Developer wrapper
IDE_date.log

•
•

EnterpriseDeveloperx??
_install_log.txt

for Enterprise Developer, where ?? is "86" for 32-bit
systems and "64" for 64-bit systems

lmsetup_install_log.txt

for Micro Focus License Administration

The log filename and folder name cannot contain spaces
The log file folder must exist before beginning the silent install

Examples
•

To silently install Enterprise Developer into a directory other than the default:
start /wait ede_22.exe /q InstallFolder=c:\DirectoryName

Installing into different Eclipse packages
Micro Focus Enterprise Developer uses Eclipse 3.8, but it will also work with Eclipse 3.7. If you want to use
Enterprise Developer in Eclipse packages based on version 3.7, you must also install the Enterprise
Developer update site, and the RSE and AspectJ plugins. The following sections show how to install into
Eclipse 3.8 and into Eclipse 3.7.
Important: We recommend you back up all existing Eclipse configuration files first.
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Installing into Eclipse 3.8
1. Install Enterprise Developer.
2. Copy the required Enterprise Developer resources to your existing Eclipse as follows:
a. Extract the contents of the following .zip files in %ProgramFiles(x86)%\Micro Focus
\Enterprise Developer\eclipse\installer (Windows) or /opt/microfocus/
<product>/eclipse (UNIX) to a temporary folder:
ajdt_2.2.2_for_eclipse_4.2.zip
RSE-runtime-3.3.zip
dtp_1.10.2.zip
emf-runtime-2.8.3.zip
emf-transaction-runtime-1.6.0M7.zip
emf-validation-runtime-1.6.0M7.zip
GEF-runtime-3.8.2.zip
org.eclipse.graphiti.site_0.9.2.201302110913.zip
wtp4x-R-3.4.2-20130208151217.zip
xsd-runtime-2.8.3.zip
Copy
the extracted folders to <your existing Eclipse>\eclipse\dropins (Windows) or
b.
<your existing Eclipse>/eclipse/dropins (UNIX).
c. Rename each of the folders:
•
•
•
•
•
•
•
•
•

From ajdt_2.2.2_for_eclipse_4.2 to AJDTUpdateSite
From RSE-runtime-3.3 to RSEUpdateSite
From EDUpdateSite to COBOLUpdateSite
From dtp_1.10.2/eclipse to DTPUpdateSite
From emf-runtime-2.8.3/eclipse to EMFUpdateSite
From emf-transaction-runtime-1.6.0M7/eclipse to EMFTransactionUpdateSite
From emf-validation-runtime-1.6.0M7.eclipse to EMFValidationUpdateSite
From GEF-runtime-3.8.2/eclipse to GEFUpdateSite
From org.eclipse.graphiti.site_0.9.2.201302110913/eclipse to
GraphitiUpdateSite
• From wtp4x-R-3.4.2-20130208151217/eclipse to WTPUpdateSite
• From xsd-runtime-2.8.3.zip to XSDUpdateSite
d. Edit the eclipse.ini file in <your existing Eclipse>\eclipse (Windows) or <your
existing Eclipse>/eclipse (UNIX):
•

•

Add
Dosgi.framework.extensions=reference:file:../dropins/AJDTUpdateSite/
plugins/org.eclipse.equinox.weaving.hook_1.0.200.I20130127-2000.jar
as a property at the end of the file
Add
Dosgi.bundles=reference:file:../dropins/AJDTUpdateSite/plugins/
org.eclipse.equinox.weaving.aspectj_1.0.200.I20130127-2000.jar@2:start,
reference:file:
../plugins/
org.eclipse.equinox.simpleconfigurator_1.0.301.v20120914-163612.jar@1
as a property at the end of the file.
Note: There is an eclipse.ini in the %ProgramFiles(x86)%\Micro Focus
\Enterprise Developer (Windows) or $COBDIR (UNIX) folder but it might conflict with the

Micro Focus Enterprise Developer 2.2 for Eclipse Release Notes

| 11

existing eclipse.ini in your existing installation. You need to decide which pieces are
relevant.
3. Restart Eclipse at the command line with the -clean option.
Installing into Eclipse 3.7
1. Install Enterprise Developer.
2. Copy the required Enterprise Developer resources to your existing Eclipse as follows:
1. From the http://www.eclipse.org website, locate the following packages from the project download
archive:
• ajdt_2.1.3_for_eclipse_3.7.zip
• RSE-runtime-3.3.zip
2. Copy the extracted folders to <your existing Eclipse>\eclipse\dropins (Windows) or
<your existing Eclipse>/eclipse/dropins (UNIX).
3. Copy %ProgramFiles(x86)%\Micro Focus\Enterprise Developer\\EDUpdateSite
(Windows) or $COBDIR\EDUpdateSite (Windows) or to <your existing Eclipse>\eclipse
\dropins\COBOL\UpdateSite (Windows) or <your existing Eclipse>/eclipse/
dropins/COBOL/UpdateSite (UNIX).
4. Rename each of the folders:
• From ajdt_2.1.3_for_eclipse_3.7 to AJDTUpdateSite
• From RSE-runtime-3.3 to RSEUpdateSite
5. Move the the contents of the <your existing Eclipse>\eclipse\dropins
\RSEUpdateSite\eclipse (Windows) or <your existing Eclipse>/eclipse/dropins/
RSEUpdateSite/eclipse (UNIX) folder up a level (that is, to <your existing Eclipse>
\eclipse\dropins\RSEUpdateSite (Windows) or <your existing Eclipse>/eclipse/
dropins/RSEUpdateSite (UNIX)) and delete the empty folder.
6. You might need to edit the eclipse.ini file in <your existing Eclipse>\eclipse
(Windows) or <your existing Eclipse>/eclipse (UNIX):
•

•

Add
-Dosgi.framework.extensions=reference:file:../dropins/AJDTUpdateSite/
plugins/org.eclipse.equinox.weaving.hook_1.0.100.HEAD.jar
as a property at the end of the file
Add
-Dosgi.bundles=reference:file:../dropins/AJDTUpdateSite/plugins/
org.eclipse.equinox.weaving.aspectj_1.0.1.HEAD.jar@2:start,reference:fi
le:
../plugins/
org.eclipse.equinox.simpleconfigurator_1.0.200.v20110502-1955.jar@1:sta
rt

as a property at the end of the file
3. Restart Eclipse at the command line with the -clean option.

Installing Micro Focus Enterprise Developer UNIX Components
Note:
•

•

12

Micro Focus Enterprise Developer UNIX Components is only available with an Enterprise
Developer or Enterprise Developer for IBM zEnterprise license and is not available with an
Enterprise Developer Personal Edition license.
If you are installing on Solaris, please read UNIX Installer Issues first.
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Downloading the Product
1. Use the download links in your Electronic Product Delivery email.
For more information follow the links for the installation instructions and the End User License
Agreement.
Installing
Note:
During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server
process (Enterprise Server Administration) runs as root as this allows it to access the system files and
ports.
All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.
By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.
These are the steps to install this product:
1. Give execute permissions to the setup file:
chmod +x setup_entdev_2.2_platform
2. Run the installer from the Process User ID login:
./setup_entdev_2.2_platform
When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.
The COBOL environment is installed by default into /opt/microfocus/product-name, (COBDIR).
To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:
./setup_entdev_2.2_platform -installlocation="full path of new location"
Note: You can use variables or the tilde syntax for the path for –installlocation. For
example, the following examples are equivalent:
-installlocation="/home/myid/installdir"
-installlocation="~myid/installdir"
-installlocation="~/installdir"
-installlocation="$HOME/installdir"
You can see details about which additional parameters can be passed to the install script if you enter
the -help option.
You can use the following options to configure the Enterprise Server installation: [ ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ],
where:
-ESsysLog

Specifies a location in which the build will create the Enterprise Server System log file for example, -ESsysLog="/home/esuser/logs". The default location is /var/
mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command
line - for example, -EDadminID="esadm". The default user ID is the one that runs the
installer.

Micro Focus Enterprise Developer 2.2 for Eclipse Release Notes
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-CASrtDir

Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Note:
•

•

The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the skipsafenet option, which skips the installation of SafeNet:
./setup_entdev_2.2_platform -skipsafenet
To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:
touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If licensing needs to be updated later, remove the file
and install Sentinel RMS server manually.

When you have installed the product, you need to set the environment as described below.
1. To set up your product, execute:
. /opt/microfocus/EnterpriseDeveloper/bin/cobsetenv
2. To verify that your product is installed, execute:
cob -V
Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.
To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as etc/profile, etc/bashrc).
Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.
UNIX Installer Issues
Licensing
Daemon

If the Korn shell is not installed on your machine when you run the installer, the
licensing daemon will not be started. To resolve this after you install the product, install
the Korn shell and then run the /var/microfocuslicensing/bin/
startmfcesd.sh script to start the daemon.

License
Infrastructure
Installer

On some Solaris platforms, you can receive the following error message when SafeNet
license server needs to be installed or upgraded on your machine:
tar: /safenet.tar: No such file or directory
To resolve this issue, wait for the installation to complete and then perform the
following:
1. Navigate to the safenet directory in the COBDIR location.
2. With superuser permissions execute: ./MFLicenseServerInstall.sh

License Server You need to configure the computer hostname to ensure the license server will start
properly.
To avoid performance issues, "localhost" and the computer hostname must not both be
mapped to IP address 127.0.0.1. You should only map "localhost" to IP address
127.0.0.1.

14
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The following is an example of how to specify these entries correctly in the etc/hosts
file:
127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname
where IP is the unique IP address of the computer in xx.xx.xx.xx format.
Preserving Configuration Settings When Upgrading Product Versions
Restriction: This topic applies to UNIX products and components only.
The Micro Focus Product Settings Backup and Restore tool allows you to backup and restore the COBOL
product configuration files and settings from one product install to another. You can also use the script to
take a snapshot of a product's settings before testing changes, and then restore the product.
The backup .tar files that the tool generates are stored in /opt/microfocus/Archive.
The following files are backed up by default:
MFDS and Enterprise Server files

bin/mfds/
etc/mfds/
etc/mfdsacfg.dat
etc/mf-client.dat
etc/mf-server.dat
deploy/.mfdeploy
etc/cas/cas.cfg

COBOL product configuration files

etc/cob.cfg
etc/cob64.cfg
etc/coboops.cfg
etc/coboops64.cfg
etc/coboops64_t.cfg
etc/coboops_t.cfg
etc/cobopt
etc/cobopt64
etc/liblist
etc/liblist64
etc/cobjvm.cfg
etc/cobisym
etc/ecm.cfg

Other files

etc/default.tcf
DemoCA/

Note: Products before Visual COBOL 2.2 and Enterprise Developer 2.2 do not contain the tool.

Syntax
The tool has the following command line arguments:
Backup_Restore.sh [-help|-h|-?|-readme ]
[ -backup -archive="location" ]
[ -restore -archive="location" ]
[ -installlocation="location" ]
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-help
Display usage message.
-readme
Display step-by-step guide.
-backup
Create a backup .tar file of product configuration.
-archive="location"
Full path to location of where to store or get backup file from.
-restore
Restore product configuration from given backup .tar file.
-archive="location"
Full path to location of where to store or get backup file from.
-installlocation="location"
Full path to location of COBDIR to be processed. If you do not know this path you can find
it using the command mfds -m.
Backing up your settings
The backup option of the tool preserves the MFDS, Enterprise Server and COBOL product settings. It does
this by creating a .tar archive of the files and places them in /opt/microfocus/Archive/ on your
machine.
You can run the tool interactively and following the on screen instructions or you can use it from the
command line as part of an automated process.
The archive file name is made up of the following parts: [ProductName][Release]_snapshot.
[MachineName].YYYY-MM-DD.HH:MM:SS.tar and you can also specify the destination of the archive
file using the -archive command line option. For example, running
Backup_Restore.sh -archive="/tmp"
on a machine call RedHatBLD against Visual COBOL 2.2 will give you a file name of
VisualCOBOLDevelopmentHub2.2_snapshot.RedHatBLD.date.time.tar.
Before performing the backup, the tool checks to see if the files exist. If they are present then in the /opt/
microfocus/Archive folder, they are added to the backup list. If they are missing, a warning is given
telling you which files are not found.
The backups can be used to take generational backups of the product setting to make sure you have the
latest settings backed up. You can also use the tool to take snapshots of the product's settings before
making changes. You can then use the backup to restore the product to a known configuration if needed.
Perform the following steps to create a backup:
1. Log on as root.
2. Set COBDIR to the product you want to backup.
3. Run the tool and select Backup from the menu.
The tool then generates the backup file and places it in /opt/microfocus/Archive/.
You can also run the tool from the command line, so the process can be automated:
1. Log on as root.
2. Run the command
Backup_Restore.sh -backup
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This creates a backup in the default area. To create a backup in a different location, log on as root and run
the following command:
Backup_Restore.sh -backup -archive="/tmp"
Restoring your settings
The tool can be used to restore backed up files for a given product. Set COBDIR to the product you want to
update the settings of and run the tool. You can then select a file to use and the script will overlay the files
in the backup archive over the top of the product.
During the restore process a copy of the files that are to be overwritten is made so that if the files from the
backup you are overlaying are not what you want or cause an issue, you can revert to the previous state.
By default all the archive files are stored under /opt/microfocus/Archive/.
To restore files in a product, perform the following steps:
1.
2.
3.
4.
5.

Log on as root.
Set COBDIR to the product you want to update.
Run the tool and select Restore from the menu.
Select the archive file you want to use.
Confirm the files listed are those you want to overlay onto the product.

The product is then updated. If needed you can perform the restore process using the tool's command line
option -restore.
Migrating settings between machines
The tool can be used to transfer settings from one product to another on the same machine or on another
machine, so that once you have the required settings in place you can roll them out to a number of
installations. To do this perform the following steps:
Log on as root.
Set COBDIR to the product containing the tool.
Run the tool and select Change COBDIR setting from the menu.
Enter the COBDIR location for the product you want to migrate the settings from, for example an earlier
version of Enterprise Developer such as version 2.1.
5. Select the Backup settings option from the menu.
6. If you want to update a product on the same machine, set COBDIR to this product using the Change
COBDIR setting menu option.

1.
2.
3.
4.

If you are updating a product on a different machine, you need to copy the .tar file created to that new
machine. The tar files can be found under /opt/microfocus/Archive. Copy the .tar file from this
location to the new machine and put it in the same directory structure on the new machine.
7. From the menu select Restore.
8. Select the archive file you want to use. It will list the files that will be restored.
The tool will then take a backup of the existing files in the product so they can be restored if required.
Configuring the Remote System Explorer Support
The remote development support from the Eclipse IDE relies upon Enterprise Developer running on the
UNIX machine and handling all requests from the IDE for building and debugging programs. Enterprise
Developer provides a UNIX daemon, the Remote Development Option (RDO) daemon, which initiates the
RDO as Eclipse clients connect to it. Whichever environment is used to start the RDO daemon will be
inherited for all servers and hence all build and debug sessions.
Configuring the Environment
You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated from one of the Eclipse clients, the environment used will be
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inherited from whatever was used to start the daemon. A typical example of the kind of environment that
might need to be set up would include database locations and settings for SQL access at build/run time.
Starting the Daemon
Important: Before starting the daemon you must have the following on your UNIX machine:
•
•
•

a version of Perl
a version of Java
the as (assembler) and ld (linking) programs on the path, as specified by the PATH environment
variable

To start the daemon on the default port (4075) as a background process, perform this command with
superuser authority:
$COBDIR/remotedev/startrdodaemon
The daemon will now listen for any Eclipse client processes connecting to that machine on port 4075. If
you want to use another port, specify another port number on the startrdodaemon command.
The daemon can also be configured to instantiate the servers on a specified port or range of ports. This is
particularly relevant when you want to only open certain ports through a firewall. To do this, perform this
command with superuser authority:
$COBDIR/remotedev/startrdodaemon [<port> | <low port>-<high port>]
where:
•

<port> is the port number the daemon should use to listen for connections from Eclipse on the client
machine. If no value is given, it will be assigned a default value of 4075. This value matches the value
assigned within the Eclipse installation.
For example,
$COBDIR/remotedev/startrdodaemon 4999

•

This command will start a daemon listening on port 4999 and will use random server ports.
<low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use
to communicate with Eclipse on the client machine.
For example,
$COBDIR/remotedev/startrdodaemon 4080 4090-4999
This command will start a daemon listening on port 4080 and server ports will be in the range 4090 to
4999.

Stopping the Daemon
To stop the daemon, type the following command with superuser authority:
$COBDIR/remotedev/stoprdodaemon <port>
Repairing on UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Installing Mainframe Access Server
Note: Mainframe Access Server is only available with an Enterprise Developer or with an Enterprise
Developer for IBM zEnterprise license and is not available with an Enterprise Developer Personal
Edition license.
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Introduction
The installation process for Mainframe Access Server (MFA) uses a single FTP operation to transfer all of
the mainframe software into a partitioned data set that you pre-allocate. When this transfer is complete, the
remaining installation activities are all done on the mainframe. You customize and submit the pre-built
FRESTORE job to restore the product data sets from the uploaded files and then continue with
customization steps to create an operational Mainframe Access Server.
Requirements
•
•
•
•
•

IBM TCP/IP 4.0, or Interlink TCP/IP 3.1 or higher
Two APPLIDs, two TCP/IP ports
Availability of APF security authorization support personnel
Access to a network share with acceptable space for source and data, as well as the ability to access
the IP address and ports used to access MFA
The following installation-specific variable information:
Variable

Description

drive
userid

TSO user-ID for FTP to your mainframe

pswd

TSO password for the FTP user-ID

your.mainframe.name

TCP/IP host name or IP address of your mainframe

prodhlq

A NEW high level qualifier that will be assigned for all
Host Connectivity data sets when the new Mainframe
Access product is installed. These are NOT existing
product data sets, but rather brand new files that you
will be creating for this base version.

Important: The installation of a new version of MFA creates new product run-time data sets
before the upgrade is applied. Any existing Host Connectivity 3.01 libraries remain intact, and can
be used for fallback. If you prefer to retain your former production library names and re-use your
existing prodhlq, rename your old libraries beforehand.
Make a note of the maintenance level of your current Mainframe Access Server. Messages
MFM0001I and MFM0014I on the syslog and XDBOUT sysout data set show the maintenance
level at startup. You may need to know what level you are upgrading from when you complete
post-installation customizations for this upgrade.
Install Mainframe Access Server
In the instructions that follow, the information that you must provide is shown as one of the variable names
from the table of information in the previous section. For example, if your high-level qualifier (prodhlq) value
is MY.MFA, then substitute MY.MFA for prodhlq.
Follow these steps to load Mainframe Access Server:
1. Download the installation file from the link in your Electronic Product Delivery email and extract its
contents to a directory on the PC.
2. On the mainframe, allocate a new partitioned data set named prodhlq.UPLOAD to receive the uploaded
files. Use the following data set characteristics for this upload library:
DSORG=PO
<=== PDS (partitioned data set)
RECFM=FB
<=== record format fixed and blocked
LRECL=80
<=== 80 character record size
BLKSIZE=3120
<=== 3120 character block size
SPACE=(3120,(3500,500,50)) <=== allocate blocks (BLKS) size 3120
3500 primary blocks
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500 secondary blocks
50 directory blocks
3. On the PC, issue the following FTP commands. The actual text of the FTP prompts and responses that
you see may differ slightly from those shown in this example.
a. Start FTP:
C:\>ftp your.mainframe.name
Connected to your.mainframe.name.
220-FTPD1 IBM FTP CS/390 VxRy at YOUR.MAINFRAME.NAME, hh:mm:ss
220 Connection will close if idle for more than 5 minutes.
User (your.mainframe.name:(none)): userid
331 Send password please.
Password: pswd
230 userid is logged on. Working directory is "userid.".
b. Change the working directory on the mainframe to be the upload library that you allocated:
ftp> cd 'prodhlq.UPLOAD'
250 The working directory "hlq.UPLOAD" is a partitioned data set.
c. Set file transfer type to binary:
ftp> binary
200 Representation type is Image
d. Set FTP prompting off to transfer all files without interruption:
ftp> prompt
Interactive mode Off.
e. Transfer all files from the extracted \Upload directory to members in the prodhlq.UPLOAD library:
ftp> mputdrive:\upload\f*
200 Port request OK.
125 Storing data set prodhlq.UPLOAD(Fxxxxxxx)
250 Transfer completed successfully.
ftp: xxxx bytes sent in x.xx seconds (xxx.xx Kbytes/sec)
.
.
.
f. When mput has transferred all files the ftp> prompt appears. End the FTP connection:
ftp> quit
221 Quit command received. Goodbye.
g. On the mainframe, verify that all files transferred successfully and that for each Fxxxxxxx file in the
\Upload directory there is a corresponding member in the prodhlq.UPLOAD data set. There should
be 10 members, F1 through to F9 and FRESTORE.
4. On the mainframe, edit member FRESTORE in the upload library, prodhlq.UPLOAD. Follow the
instructions in that member to customize the JCL and then submit that job to restore the product
libraries from the uploaded files and populate your new product runtime libraries.
5. Start Mainframe Access Server.
After installation
Since the program libraries can change between versions, it is necessary to either create new procedures,
or back up the old procedures, and at least modify the DSNQUAL=prodhlq within your MFA sample started
task procedures as provided by Micro Focus. The prodhlq.LOADLIB and prodhlq.SASC.LINKLIB must both
be authorized.
Verify successful maintenance application by checking the Mainframe Access Server startup message:
MFM0001I: Mainframe Access V4.00 (BASE ) is active
The "(BASE )" indicates the product maintenance level. Also check for "V4.00" in the Mainframe Access
Data Connect server startup message:
MFA303I MFA/DATACONNECT V4.00 - BASE COPYRIGHT (C) 1987-2012 MICRO FOCUS...
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When you are satisfied with the new version installation you may delete the UPLOAD data set from your
system.
New parameters and members in the CNTL samples data set
The following updated members are found in the CNTL data set.
MFA

sample MFA started task

MFAS

*new* sample MFAS started task for Data Connect

MFAAS

sample MFAAS application server started task

MFAVTAM

sample MFA VTAM definitions

PARMS

sample PARMS for MFA started task

PARMSAS

sample PARMSAS for MFAAS started task

SERVERS

sample SERVERS configuration for MFA

UPQUICK

configuration notes

If you are migrating from Host Connectivity 3.01 WebSync 10 or earlier, you may want to retain your
existing CNTL members from your current version as an installation test. You can simply copy the existing
MFA started task JCL and change the STEPLIB to reference the new product libraries. You will however
need to modify the MFAS started task JCL since the module names for Data Connect have been changed
to allow co-residence within the same authorized library as MFA.
Review the Change Log in each of the new members. Read the documentation for any new parameters in
the Readme and in the updated Mainframe Access Administrator's Guide. Add these new parameters and
other changes to your working copies. If necessary, customize the new parameters for your installation.
Once you are satisfied with the operation of Mainframe Access, you can consolidate the configuration
settings into the new high-level qualified CNTL members.

Installing the mainframe components
Mainframe z/Server
The mainframe z/Server is a z/OS server that supports the Eclipse mainframe integration, and is provided
with Enterprise Developer for IBM zEnterprise. z/Server needs to be installed before mainframe access is
enabled.
Refer to the document z/Server Installation Guide for instructions on how to install Enterprise Developer's
mainframe components.
To define
default z/
Server
connections

Enterprise Developer supports the configuration of default connections. Default
connections can be defined by creating a file called defaultZConnection.ini in the
Eclipse folder of your Enterprise Developer installation.
The contents of this file must follow these syntax rules:
•
•
•

Every line must contain one attribute or start with # (Comment)
Every connection must start with >CONNECTION and end with >END_CONNECTION
Every connection must be defined with following attributes:
NAME

The name of the connection - this must be unique

HOST_ADDRESS The physical address of the host (for example 192.168.1.1,
localhost)
PORT

The port of the z/Server (scheduler)
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DESCRIPTION

The description of the connection - this can be left blank

A sample file is included in the installation.
When Enterprise Developer successfully parses the defaultZConnection file, it
creates a z/OS connection in the Remote Systems View for every configured default
connection.
Important: Enterprise Developer reads the defaultZConnection file only
once for each workspace. This means that any changes relating to default
connections will not apply to existing workspaces that have already been used.
Assuming you have the appropriate Enterprise Developer for IBM zEnterprise license,
after installing z/Server you should verify the connectivity.
To verify
mainframe
connectivity

1. Start Eclipse.
2. Ensure the Team Developer perspective is loaded. If it is not visible, select Window
> Open Perspective > Other > <Team Developer>.
3. Right-click in the Remote Systems view and select New > Connection.
4. Select "z/OS" from the connection list and click Next.
5. Enter the TCP/IP address or name of your mainframe system and enter a connection
name that will be displayed in the view. Click Next.
6. Enter the correct connection port and the default encoding parameters. Ask your
system administrator if you do not know the correct parameters.
7. Click Finish. The z/OS entry is added to the view.

To verify the
client host
connection

1. Start Eclipse and switch to the Team Developer perspective.
2. Expand the z/OS connection entry in the Remote Systems view. If the z/OS entry is
not shown in this view, verify the client installation process first.
3. Right-click on the MVS entry and verify, or customize, the port number of the z/
Server server (the default is 1111).
4. Right-click on the MVS entry and select Connect.
5. Enter your mainframe user ID and password and click OK. After a successful
connection the color of the icons changes to green.
6. Right-click again on the MVS entry and select Disconnect to disconnect from the
host system.

Mainframe Access server (MFA)
Mainframe Access is the OS/390 and z/OS server for Micro Focus development environments. It is a
common component providing access to host resources for environments. One installation of Mainframe
Access can support all of these products, providing connectivity to any number of DB2, IMS, and CICS
systems located anywhere in an enterprise. It can also provide access to JES facilities, VSAM data sets,
non-VSAM data sets, and data controlled by external library management products such as Panvalet,
Librarian and Endevor.
Features include:
•
•

•
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The Drag and Drop utility allows you to transfer files using drag and drop methods, between the
mainframe and the PC environments.
The Remote Job Step Execution (RJSE) facility enables execution of one or more steps of a job on a
remote z/OS host. It automatically uploads and downloads required files as necessary with an end
result the same as when all steps are executed locally.
Compare and Synchronization Monitor allows you to mirror mainframe data sets against either
workstation directories, or PVCS archives. This mirroring, known as synchronizing, can occur in either
direction, or both directions. Typically, a user would synchronize mainframe partitioned data sets or
source control systems with a workstation directory for download.

| Micro Focus Enterprise Developer 2.2 for Eclipse Release Notes

•

You can use SourceConnect to map a PC drive to a mainframe dataset. You can then access
mainframe files and resources from a PC, or from applications running on a PC.

After Installing
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the COBOL
perspective after installation:
1. Open the existing workspace with this product.
2.
3.
4.
5.

You may receive some warnings or errors which you can ignore.
Make sure you are in the COBOL perspective by clicking Window > Open Perspective > COBOL.
Click Window > Reset Perspective.
Click OK.
Reapply any customizations.
Note: For applications created with earlier Micro Focus products, note the following:
Existing
Applications

Application executables that were compiled using earlier Micro Focus products
must be recompiled from the sources using Enterprise Developer. For more
information, read the section Upgrading to Enterprise Developer for Eclipse in
the product Help.

Installing X Windows on Windows
Some features of Enterprise Developer for Eclipse on Windows require an X Windows installation, hence
Micro Focus ViewNowX is provided with the product. To install, run the file ViewNow_X_Server.exe in
your Enterprise Developer installation. By default this will be in the %ProgramFiles(x86)%\Micro
Focus\Enterprise Developer\ViewNowX folder.
ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.
To repair your installation on versions of Windows Vista or later:
1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling
Windows
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:
1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.
When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.
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Important: The installer creates separate installations for Micro Focus Enterprise Developer and
Micro Focus License Administration. Uninstalling only Enterprise Developer does not automatically
uninstall the Micro Focus License Administration or any of the prerequisite software.
To completely remove the product you must uninstall the Micro Focus License Administration as well.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:
start /wait install-file.exe /quiet /uninstall
UNIX
Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.
To uninstall Micro Focus License Administration:
1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.
The script does not remove some of the files as they contain certain system settings or licenses.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Licensing Information
Note:
•
•

•

If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.
The Enterprise Developer Personal Edition option is not available with this release. In order to use
this product, you need purchase the full unlimited license for it.
You can use the Personal Edition option if you install the previous release, Enterprise Developer
Personal Edition 2.1 Update 1. When you start the product, follow the links in the Micro Focus
Enterprise Developer Product Licensing dialog box to activate the free product.
Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if
you wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To buy and activate a full unlimited license
1. In the IDE, click Help > Micro Focus > Product Licensing > Buy Now.
This opens the Micro Focus Buy Now dialog box.
2. Ensure that the email address you used to register the product is in the Email address text entry field.
3. Click Send email.
This opens your default mail client and creates a new email filled in with the details to contact Micro
Focus. Send the email.
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If there is no mail client installed on your machine, you will be presented with a template that includes
the email address and subject line for an email to send to Micro Focus using a mail client of your
choice.
You will be contacted by a Micro Focus Sales representative.

To start Micro Focus License Administration
Windows
From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.
Note: On Windows 8 and Windows Server 2012, you use the Start screen to invoke programs.

UNIX
Log on as root, and from a command prompt type:
/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses
If you have a license file
Windows
1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:
•

Click Browse next to the License file field and select the license file (which has an extension
of .mflic).
• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.
4. Click Install Licenses.
Alternatively, you can install the license file from within the IDE as follows:
1.
2.
3.
4.
5.
6.

Start Enterprise Developer.
Click Help > Micro Focus > Product Licensing to open the Product Licensing dialog box.
Ensure I have a full Enterprise Developer Team Edition license is checked.
Click Browse next to the License file field.
Select the license file (which has an extension of .mflic), and then click Open.
Click Finish to install the license.

UNIX
1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.
2. Enter the name and location of the license file.

If you have an authorization code
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Authorizing your product when you have an Internet connection
Note: This topic only applies if you have an authorization code.
The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.
Windows
1.
2.
3.
4.

Start Micro Focus License Administration.
Click the Install tab.
Type the authorization code in the Enter authorization code field.
Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.
UNIX
1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter
Authorizing your product when you don't have an Internet connection
Note: This topic only applies if you have an authorization code.
This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.
Windows
1.
2.
3.
4.

Start Micro Focus License Administration.
Click Manual Authorization on the Install page.
Make a note of the contents of the Machine ID field. You will need this later.
Do one of the following:
•
•

If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.
If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.
10.Click Install Licenses.
UNIX
In order to authorize your product you must have the following:
•
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Your authorization code (a 16-character alphanumeric string).
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•

The machine ID. To get this, start the Micro Focus License Administration tool and select the Get
Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.
1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.
2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.
3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by
inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.

New Features in Enterprise Developer 2.2
Note: There are differences between the variants of Enterprise Developer you might have installed.
Enterprise Developer Personal Edition provides a development environment that supports analysis,
editing and syntax checking of COBOL and mainframe programs outside of the mainframe
environment. It does not, however, support off-mainframe debugging, unit testing, or building of
projects. To build, debug, and execute the demonstration application, you need Enterprise Developer.
COBOL copybook project types
You can use the COBOL Copybook and Remote COBOL Copybook project types to hold several copybook
files, which can then be added as dependent projects to the build path of other source projects. Copybook
projects are not compiled, thus saving processing time and resources.
In these projects you can only create new, and add existing, .cpy and .cbl files, but files with the .cbl
extension are treated as copybooks.
COBOL Source Information (CSI)
COBOL Source Information (CSI) provides a quick and easy way of providing you with information about
your program when you are working on it. You enter a query in the Quick Browse dialog box and CSI
returns the results of the query in the Search view.
Compiler directives
The following Compiler directives are new:
ACU-UNDERSCORE

This directive treats underscores in COBOL words as hyphens.

ILSHOWPERFORMOVERLAP This managed COBOL-only directive generates a warning when an
overlapping PERFORM range is detected in the program.
ILEXPONENTIATION

This managed COBOL-only directive enables you to optimize
exponential arithmetic operations by specifying the calculation method
used.
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EXITPROGRAM

This directive determines how the EXIT PROGRAM statement is
executed.

The following Compiler directives have changed:
CHANGE-MESSAGE The scope of this directive has been widened to allow you to change the severity
of different types of error messages, not just syntax checking messages.
DIALECT"RM"

DIALECT"RM" now sets PERFORM-TYPE"RM". If you recompile an application
that uses DIALECT"RM", the behavior may change for nested PERFORM
statements. If that is the case, explicitly set PERFORM-TYPE"MF" after
DIALECT"RM" to continue with the previous behavior.

HIDE-MESSAGE

The scope of this directive has been widened to allow you to hide different types
of error messages, not just syntax checking messages.

PRESERVECASE

This directive now defaults to PRESERVECASE when compiling native COBOL;
managed COBOL compilation already defaults to PRESERVECASE. This results
in externally visible identifiers preserving their case instead of being converted to
uppercase.

Consolidated copybook paths dialog box
You now set the paths for COBOL, IMS, and PL/I copybooks (where available for the project type) in a
single Dependency Paths page of the project properties dialog box.
Documentation
The following guide is now available, among other updates to the product help for this release:
Object-Oriented
Programming

A guide that provides a basic introduction to Object-Oriented Programming (OOP)
for COBOL developers, An Introduction to Object-Oriented Programming for
COBOL Developers, is now available from the Product Documentation section on
the Micro Focus SupportLine Web site - click here to download it.

Eclipse 3.8
Enterprise Developer is shipped with Eclipse 3.8, and can also be installed in existing instances of Eclipse
3.7 and 3.8.
Enhanced Enterprise Server integration with the IDE
This release provides the following enhancements:
•
•
•
•

Creating a server from a template directly from the Server Explorer window.
Automatically starting the associated server and enabling dynamic debugging for it when you start
debugging.
Showing the spool and the catalog of the associated server from the context menu for the project in
COBOL Explorer.
Debugging applications using a temporary server when the project has no association with any of the
existing enterprise servers.

File Handling
New features include:
•
•
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The DATEDIFF function as part of the DFSORT emulation. There are some limitations of its use in
Enterprise Developer.
Converting and editing Vision and RM/COBOL indexed data files using the Data File tools.
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•
•

Access to data files (either sequential or indexed) through AcuServer.
Access to Vision and RM/COBOL indexed data files through Enterprise Server.

HCO for SQL Server (HCOSS)
Several updates have been made to the HCOSS tool set:
DB2 database batch
migration

This set of batch utilities provides an alternative to the standard HCOSS
database migration tools.
Note: This feature is in early adopter release status. We intend to provide
the finalized feature in a future release. Please contact Micro Focus
SupportLine if you require further clarification.

Schema Extract tool

This tool now provides:
•
•
•

Updated security that enables users to study extracted schemas without
accessing the catalog
Extracted schema modification
Export and import capabilities

Application
Assessment tool

This tool now enables you to perform data analysis on schema extract files and
identify structures that are not supported by SQL Server, or that could require
manual modification before HCOSS can accurately transfer the data to SQL
Server.

OPTION SQL
compiler directive
option

New parameters have been added to handle additional host variable types.

IMS
Database recovery IMS database recovery using the new IMS Database Forward Recovery and
Rollback Recovery features is available. These consist of a set of backup and
restore utilities that enable you to restore your IMS database complete with the
most recent updates.
Locking
improvements

Internal Resource Lock Manager (IRLM) support has been added to provide more
granular locking capabilities, allowing for increased sharing and decreased
contention and deadlock risk.

Java Web services support
Enterprise Developer supports the development, compilation, debugging, and deployment of JVM COBOL
web archives to JVM servlet APIs and common Java Enterprise Edition (JEE) application servers.
JVM COBOL Web services support
Support for calling COBOL programs from JSPs and servlets has been expanded to offer more COBOL
features, improved IDE tools, and more runtime support.
Mainframe Access Drag and Drop
This release provides the integrated Drag and Drop utility - based on the traditional standalone version of
Drag and Drop, you can now transfer files to and from the mainframe from within the IDE using the Micro
Focus Mainframe Explorer. This version also enables you to view and edit mainframe files.
The standalone version can no longer be invoked using the command line command mfdasmx2; use the
command mfdasmx instead.
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Mainframe snippets
A number of code snippets for inserting EXEC CICS and EXEC DLI statements in the code are now
available for Mainframe Subsystem applications. You can insert code snippets from the context menu in
the editor or by pressing Control + Space and selecting a keyword. You can modify the keywords for the
mainframe snippets in the IDE from Window > Preferences > Micro Focus > COBOL > Editor >
Templates.
Mainframe Subsystem Support
JCL System
Catalog

You can now use in-stream data for DDs within JCL procedures. This change is to
maintain compatibility with mainframe JCL processing which recently introduced the
same change.

JCL Public
Catalog API

You can now access and update JES Catalog information.

IMS database
utilities

The database utilities commands Zeroload, Load, Unload and Add are now
available from the context help menu for .dbd files in COBOL Explorer.

CICS External Call Micro Focus proprietary support for the CICS External Call Interface (ECI) has been
enhanced. ECI uses the Micro Focus BINP protocol, thus eliminating the need for
Interface (ECI)
third-party middleware. Additional features include support for extended LUW
(logical unit of work) and new support for Java clients. For more information, see
IBM External Call Interface (ECI) and External Presentation Interface (EPI).
Managed COBOL
Named and
optional
parameters

Delegates
and events
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Two new types of parameter have been introduced for use during method invocation:
Named
parameters

As part of the invocation expression, you can define a value for a
parameter named in the method definition. The named argument
must be specified after any positional arguments, and must not
correspond to any of those preceding arguments.

Optional
parameters

Optional parameters are parameters defined with a default value in
the procedure division header of the invoked method. If none of the
arguments passed in during invocation correspond to this parameter,
the default value is used in the method; if an argument does
correspond, the value that was passed in is used.

A number of new features have been added that relate to delegates and events:
Note: Some of these features were also available in previous versions of Enterprise
Developer.
The ATTACH and
DETACH statements

Use these statements to attach or detach a delegate, method
group or an anonymous method to or from an event.

The RUN statement

Use this statement to invoke a delegate once it has been
created.

Combining
delegates

Use the '+' operator to add a method group, anonymous method
or another delegate to a delegate, and use the '-' operator to
remove a method or another delegate from a delegate.

Method groups
conversions

Use the METHOD keyword to specify a compatible method
from a method group, and convert it to a delegate.
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PL/I Parsing Editor (Early Adopter Program) - available with Enterprise Developer 2.2 HotFix 3
(January 2014)
With the Enterprise Developer Connect and Enterprise Developer licensing options, you now receive a new
and enhanced PL/I Parsing Editor alongside the standard PL/I editor. The new editor is designed for editing
remote mainframe programs and enables you to perform syntax check of the code before it is compiled on
the mainframe.
To invoke the new editor to edit your sources – in the IDE, right-click a PL/I program in your project, and
click Open With > PL/I Parsing Editor (Early Adopter).
Features of the PL/I Parsing Editor include:
•

•
•

Colorization - you can configure the print margins, syntax colorization or the code snippet templates to
use in the editor in the IDE from Windows > Preferences > Micro Focus > Early Adopter Program >
PL/I Parser Editor.
Syntax checking support – use the PL/I local syntax check context menu command to start a syntax
check of the PL/I sources.
Navigation in the PL/I sources using:
•
•

The PL/I jump to procedure (or F10) context menu command on CALL statements in the code to
navigate to the place in the code where the procedure in the CALL statement is defined.
The Outline view shows the structure of the PL/I source that you are currently editing.

The PL/I Parsing editor is a work-in-progress and might change in future releases of the product.
PL/I support
•
•
•
•
•

EBCDIC support
Support for XML (using XMLCHAR, PLISAXA, PLISAXB, and PLISAXC)
Preprocessor support for programs written using EXEC DLI
Support for PL/I programs running MQ Series
Support for Open PL/I programs running as DB2 stored procedures

Problems view
The Problems view now has a 'Program' column that displays the name of the program in which the
problem occurred. Click this column heading to sort the errors by program.

If the column is not present in the view by default, you can add it through the Configure Columns dialog
box in the View Menu.
Quickfix for missing copybooks
When paths containing copybooks are added to a project, they are not automatically added to the
copypath. This can cause confusion when a copybook is in the project but the program is not compiling.
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The Eclipse Quickfix feature now hints how to resolve the problem, and offers a solution (which is to add
the path onto the copypath).
SQL
SQL tooling has been integrated into the Eclipse IDE:

Eclipse IDE

•
•
•

HCO for SQL Server tools
OpenESQL Assistant
Options for the level of background parsing for DB2, XDB, and
OpenESQL statements

Enables you to get diagnostic information for the last OpenESQL statement
EXEC SQL GET
DIAGNOSTICS Statement executed.
External Compiler
Modules (ECM)

ECM support has been expanded and includes OpenESQL, HCO for DB2
LUW, and XDB.

OPTION compiler
directive option

New parameters have been added to handle additional host variable types.

XA switch modules

This release includes support for XA switch modules that enable CICS- and
JES-initiated transactions to run under Microsoft SQL Server using different
user credentials than those specified within the XA open string.

Viewing copybook dependencies
By expanding a source file node in COBOL Explorer, you can see a list of all copybooks referenced in the
source code, and nested within them any other copybooks referenced by those copybooks.
You can also use the Copybook Dependency view to show where in the source file's structure the COPY
statements appear, and which copybooks they reference.
Click a copybook reference in the Copybook Dependency view to open the file containing the associated
COPY statement at the appropriate line.
Double-click a copybook reference in COBOL Explorer or Copybook Dependency view to open the
copybook file.
XML Extensions
You can now use XML Extensions in your managed COBOL projects.

Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.
In addition, note the following:
AcuCOBOL
File Handler

When using an interface of ACUFH other than MSSQL, you may experience a file
operation delay when the interface fails to connect to a database. This failed connection
also results in a memory leak. Set the environment variable MSSQL_DETACH to 1 to
avoid both issues.

CICS

•
•
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An EXEC CICS DELAY statement may sometimes produce a difference of one
second.
When Enterprise Developer for Visual Studio is initially installed, no CICSECM
directives will be set on assembler files that are added to a project even when the
IDE is configured to do so. To work around this problem, click Tools > Options >
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Micro Focus > Directives. Disable and then enable the check boxes under COBOL
CICS and Assembler CICS.
COBOL
Watchpoints

The debugger ignores a COBOL watchpoint that is hit if there is no statement following
the statement that modifies the data on which that watchpoint is set.

Compiler

When running with Java 1.7, if your class contains a static method called 'main' with a
single string array parameter, in order for this class to be executable from the command
line that main method should not have a returning item.

Debugging

There is an issue with "Wait for attachment" when you use Enterprise Developer for
Eclipse to debug applications that run on some UNIX/Linux platforms. Eclipse connects
to the debugger on the remote machine, but might not attach to the process to debug
the code.
To work around this issue, ensure that on the remote machine the TMPDIR
environment variable is unset or has the same value for both Micro Focus Enterprise
Developer UNIX Components server and for the running process you wish to debug.
The Micro Focus Enterprise Developer UNIX Components server is the server which
you started either directly with the $COBDIR/remotedev/startrdoserver script or
indirectly using the daemon which is started with the $COBDIR/remotedev/
startrdodaemon script.
To check the variable used by the Micro Focus Enterprise Developer UNIX
Components server:
1. Open Remote Systems view in Eclipse on the Windows machine.
2. Right-click the Shells element of the server connection to be tested and click
Launch Shell.
3. In the Remote Shell view, type echo $TMPDIR in the Command field, and press
Enter.
The value of the TMPDIR environment variable is shown - ensure it is the same as
the one used by the process to be debugged.
Note: The value of TMPDIR used by the Development Hub server cannot be
changed in the remote shell and must be set before you start the daemon or
server.

Database
Access

If you have a remote COBOL project under Eclipse that uses DB2 ECM in Visual
COBOL or HCO for DB2 LUW in Enterprise Developer and the DB2 software is not
installed on the client machine where you are using the Eclipse IDE, you receive
background parsing errors in your application. To resolve the issue, you can do either
one of the following:
•
•

Disable background parsing Window > Preferences > Micro Focus > COBOL >
Editor and disabling the checkbox for Background parsing.
Install the IBM DB2 client-side software on the machine on which you are running
Eclipse. Go to the IBM Support Home and locate the page entitled "IBM Download
Fix Packs for IBM Data Server Client Packages" .

Enterprise
Server

•

ICETOOL
Emulation

ICETOOL emulation for managed code is not available in this release.

Installation

•

The Historical Statistics Facility may generate incorrect records for SSTM-enabled
enterprise servers.

On UNIX, check UNIX Installer Issues before you start the installation.
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•

If you are using the latest version of Java 1.7 on Linux, you might receive some
warnings when you start this product. To resolve the issue, it is recommended that
you install an earlier version of Java 1.7 and set JAVA_HOME to that.

JCL VSE

When running Enterprise Server applications on HP Itanium in 32-bit mode, if you
receive an error such as "CASCD1057S JES Initiator for Server ... abended by signal
00004", you need to set the environment value COBMAINSTACK to a value greater
than 500000 to increase the default stack size.

Micro Focus
Rumba

On versions of Windows Vista and later, Enterprise Server listens only on the IPv4
loopback address (127.0.0.1). As a result, an attempt to connect to localhost with a
TN3270 emulator such as Micro Focus Rumba may fail. To work around this issue, in
your emulator's configuration use 127.0.0.1 in preference to localhost or your host
machine's name.

Open PL/I

Currently, the Open PL/I Codewatch debugger does not run on 64-bit Windows 8.

Resource
Adapters

Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may
fail with a ClassCastException. To work around this issue, you need to deploy
mfcobol-xa.rar first, then need to undeploy this file and deploy the local one,
mfcobol-localtx.rar. If there are issues deploying using the WebLogic GUI, you
can use the command line. If there are issues with this as well, try reducing the length
of the command (for example, by moving the file to a location with a shorter path).

Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

ASM Compiler: HLL Macro Assembler
CAS (COBOL App Server) General
CCI Session Layer Code
Compiler
Eclipse IDE
File Handling - Sort / JCL Sort
JCL System Catalog - Dataset Allocation
MF Directory Server
MF Server Administrator (GUI)
MFBSI
MTO - IMS Other
MTO - JCL MVS
MTO - JCL System Catalog
Open PL/I Compiler
Open PL/I Debugger
Open PL/I RTS
Request Handler

ASM Compiler: HLL Macro Assembler
Back to the list
•
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A "." (dot) specification is no longer ignored in the SYSIN environment variable or in the mf370ctl.cfg file
when used to specify an output directory, and indicates the current directory. This is a change in
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•

behavior from Mainframe Express, where the "." (dot) character in the SYSIN environment variable or in
the mf370ctl.cfg file is still ignored and assembler output files are placed in the directory specified by the
SYSIN environment variable.
Assembler Build Output will now be sent to the location specified in the COBOL output path project
setting. Previously, all Assembler build output went to the project directory.

CAS (COBOL App Server) General
Back to the list
•

Previously, on cancelling an active JCL job on UNIX (after you have used STOP on the ESMAC > SEPs
page to stop the INITIATOR that it is running in), the INITIATOR was terminated and a new one was
restarted in its place. Now, the new INITIATOR will not be started, as the STOP request was received
before the CANCEL.
2559087 (1084226)

CCI Session Layer Code
Back to the list
•

A new option, use_global_namespace, is available for the cci.ini file in the Windows %SystemRoot%
folder. If use_global_namespace is set, all the ccishared memory objects are created in a system-wide
address space, and the applications hosted by different users, including system services, can
communicate. To use this facility, edit the cci.ini file and ensure use_global_namespace is set to "yes".
[ccismem-base] # Allow interaction between users on a # single system. Using this option reduces
security as # all users will have access to the same name space. use_global_namespace=yes If the
value of this option is anything other than "yes", or if the option is missing, no change is made to the
existing behavior.
2195519 (1062800)

Compiler
Back to the list
•

•

•

The default for the NSYMBOL directive under DIALECT(ENTCOBOL) has been changed to
NSYMBOL(NATIONAL) to emulate the equivalent IBM default.
2657471 (1090355)
To improve RM/COBOL and ACUCOBOL compatibility, the SIGN clause at a group level is no longer
applied to non-DISPLAY usage signed numeric data items within the group, just as it is not applied to
unsigned numeric data items and non-numeric data items within the group.
2549904 (1082171)
Previously, even though no code was generated, the Compiler allowed the ON EXCEPTION and NOT
ON EXCEPTION phrases in the DISPLAY statement in formats that do not allow these phrases. As a
result, if the DISPLAY statement was in the ON EXCEPTION phrase of another statement, the NOT ON
EXCEPTION phrase would bind incorrectly with the DISPLAY statement instead of with the intended
containing statement - for example, ACCEPT or CALL.

Eclipse IDE
Back to the list
•

•

The Problems view now has a 'Program' column that displays the name of the program in which the
problem occurred. If the column is not present in the view by default, it can be added through the
Configure Columns dialog box in the View Menu.
2608496 (1088530)
The outline of the ruler in the COBOL editor now changes on modelChanged depending on the current
source format.
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•
•

2488419 (1077143)
Deleting a Web service or a Java interface mapping now deletes the files relating to it from the repos
directory and, if it is empty after the files have been deleted, will remove the repos directory itself.
The IDE now performs an automatic directive determination when files are added to a project. You can
also use a command to perform directive determination of the project manually.

File Handling - Sort / JCL Sort
Back to the list
•

When used with MFJSSTRICTSORT=ON, MFJSORT now errors (return code 16) if the input RECFM is
different to a SORTOUT RECFM. It also errors if the input RECFM is different to an OUTFIL RECFM
when FTOV or VTOF/CONVERT has not been specified.
2643384 (1088993)

JCL System Catalog - Dataset Allocation
Back to the list
•

The default for previous releases was to create a catalog entry with no physical file until data was
actually written to the catalog. Now, a PC file is allocated for non-VSAM files by default. You can
emulate the previous behavior if you set the environment variable MFALLOC_PCFILE to N.

MF Directory Server
Back to the list
•

•

The mfds command line option for exporting registered Enterprise Server definitions to an XML file now
supports the "*" option. This exports all registered servers rather than a specified server. Multiple server
definitions are now exported into the target directory and saved into a file with the default name
ALLSERVERS.xml. The import option now also supports the import of multiple server definitions from a
single XML file.
2641890 (1088838)
mdump now supports a new option, -e, to help you query the Security Manager configuration details.
The possible values of the option are: "1" - shows security configuration that applies to any returned
enterprise servers; "2" - shows security configuration for MFDS and the default Enterprise Server
security configuration. This requires MFDS version 1.15.00 or higher; "3" - returns the properties of all
configured external Security Managers.
2487164 (1081693)

MF Server Administrator (GUI)
Back to the list
•

When adding a user to an external security manager, you can now include a password expiry time in
the Advanced Configuration section of the Add New User wizard in Enterprise Server Administration.
The field value is specified using generalized time format (YYYYMMDDHHMMSS.0Z), and can be used
by the MLDAP ESM for calculating whether a user's password has expired and requires updating. This
value may only be specified using this page when adding a user. You need to use an external directory
services configuration tool to edit it.
2562118 (1083203)

MFBSI
Back to the list
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•

casout now correctly sets return-code to the job status for the sysout retrieval when the file is less than
65K. Also, MFBSI now considers return codes of 0, 7 or 8 to be successful for JESYSMSG retrieval
where, previously, it only considered 0 as successful.
2655482 (1090444)

MTO - IMS Other
Back to the list
•

The DBDCPY, MFSCPY, and PSBCPY environment variables are no longer required and have been
deprecated. Use the IMSCPY environment variable to specify copybook locations.

MTO - JCL MVS
Back to the list
•

•

Empty values for the USER or NOTIFY parameters on the JCL JOB card no longer cause an error
when parsing the JCL.
2646770 (1089380)
The disposition processing of PASSed datasets has been revised to be consistent with mainframe
processing. Particularly, received datasets are removed at the end-of-step processing, unless they are
to be passed on to another step in the job. Any passed datasets that were not received at the end of the
job may be removed if they conform to the mainframe conditions for this.
2610362 (1087601)

MTO - JCL System Catalog
Back to the list
•

The value for the JCL DD UNIT=device parameter is now stored in the system catalog entry for the
dataset.
2619050 (1089095)

Open PL/I Compiler
Back to the list
•

If using the -cics, -ims, or -mvs options when compiling on a little endian platform, the possibility for
errors existed. Starting with this release, using the -cics, -ims, or -mvs options automatically uses bigendian, thereby eliminating the possibility for these errors. Evaluate any applications that were built
with a prior release to determine any impact on any data files being used, or where programs compiled
with the -mvs option pass data to sub-programs compiled without it. The -bigendian option can be
suppressed by adding the -native option after the -cics, -ims, or -mvs options.

Open PL/I Debugger
Back to the list
•

•

CodeWatch no longer attempts to use an incorrect directory when starting. Also, CodeWatch is now the
default debugger when no other debugger is specified, and is the only debugger available when using optexec plitest.
2655906 (1090193)
Support for the evaluation of X, NX, Z, A, and E constants nas been added to CodeWatch.

Open PL/I RTS
Back to the list
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•

•

•

A problem with possible truncation or trailing zeroes within PICTURE assignments has been fixed. As
the fix depends on changes to both the Compiler and the run-time, you must perform a complete rebuild
of all your source code (recompile and relink) in order to apply it.
2662261 (1090768)
Previously, when taking a PLIDUMP, if the .PDB file needed for a PLIDUMP was not in the same
directory as the .DLL and the .STB files, and they were not in the first CAS_BATCH_PATH
subdirectory, then the PLIDUMP was not successfully generated and an S0C4 abend could occur.
2615412 (1090483)
The Open PL/I debugger no longer loses its place and behaves erraticly when debugging code
containing the same PL/I macro multiple times within the same source routine, even if the -nodebuginfo
and -pp options are not specified.
2612530 (1087809)

Request Handler
Back to the list
•

A problem that caused BIS to create log files in a directory named C:\ProgramData\AcuCorp\BIS
\LogFiles was fixed. BIS no longer creates log files unless specified and the BIS logging service is now
disabled by default. To enable it, you need to use the following global environment variable:
BIS_LOG=[ OFF | ON | <directory> ] Where the values are:
•
•
•

OFF - disables logging (the same as if BIS_LOG is not specified or is left blank)
ON - enables logging and directs the log files into the default location, which must not be read-only.
<directory> - enables logging and directs the log files into the specified directory. The user must
ensure that the BIS request handler has write rights for this directory. The directory must be an
absolute path or network path. If the specified directory does not exist, BIS will attempt to create it.
The containing directory must exist.

The BIS_LOG variable is only examined when the BIS application pool is started or recycled. After
setting or changing BIS_LOG, IIS must be restarted in order for the variable to take effect.

Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
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Adis
Animator (Character version)
ASM Compiler: HLL Macro Assembler
CAS (COBOL App Server) General
CAS Security
CAS XA Switch modules
CCI TCP/IP
Compiler
CICS: Problems not classed above
Cob/Cbllink/Cblnames (32-bit PC)
Data Tools Converter
Data Tools Editor
Data Tools Layouts
Debugger
Documentation
Eclipse - Debug
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•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Eclipse IDE
File Handling - External File Handler
File Handling - Fileshare
File Handling - Sort / JCL Sort
IDE Debugging
IDE Mainframe Explorer
JVM - Compiler
JVM - RTS
Macro Preprocessor
MF Common Client
MF Communications Server
MF Directory Server
MFA: GUI components
MFA: Mainframe
MFBSI
MTO - CICS BMS Screen painter
MTO - CICS ECM/Preprocessor/Translator
MTO - CICS Emulation
MTO - CICS ESMAC
MTO - CICS Utilities
MTO - IMS DB
MTO - IMS ESMAC
MTO - IMS TM
MTO - IMS Utils
MTO - JCL ESMAC
MTO - JCL MVS
MTO - JCL System Catalog
MTO - JCL TSO
MTO - JCL Utils
MTO - JCL Utils - IDCAMS
MVS REXX Emulation
NCG
Open PL/I CICS Preprocessor
Open PL/I Compiler
Open PL/I Compiler Back-End
Open PL/I Debugger
Open PL/I Macro Preprocessor
Open PL/I RTS
Open PL/I SQL Preprocessor
RTS
Samples Browser
Setup Issues
Setup Issues (UNIX)
SQL: DB2 ECM
SQL: HCO for SQL Server
SQL: OpenESQL
Vision File System
XML Extensions
XML syntax support runtime
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Adis
Back to the list
•

•

Statements of type "DISPLAY SPACES AT LINE... POSITION... SIZE..." now only clear the screen at
the specified coordinates and for the specified size.
2644054 (1089103)
The Compiler and ADIS now support RM/COBOL ACCEPT and DISPLAY behavior, including when the
Compiler DIALECT(RM) directive and the RM2VCOB configuration in ADISCTRL are both used.
2616898 (1088510)

Animator (Character version)
Back to the list
•

Animator now displays the correct program name on the status bar.

•

2475333 (1076125)
An error message is now displayed if there is a problem accessing the terminal when animating using
Character Animator.
2050690 (1050314)

ASM Compiler: HLL Macro Assembler
Back to the list
•
•

Assembler macro IEFZB4D0 now compiles cleanly.
2192729 (1062581)
MF370CHK now accepts spacey filenames if they are enclosed in double quotes. When assembling
programs from the command line, you need to enclose spacey paths and filenames in double quotes for example: RUN MF370CHK "C:\DIR\D IR\TEST.MLC" NOANIM

CAS (COBOL App Server) General
Back to the list
•
•

•

•

•

casgate no longer crashes when it receives a shutdown request from MFCS.
2657261 (1090327)
When an MFCS process terminated while it was processing an EZASOKET function for an application,
the SEP remained in a waiting state indefinitely. Recovery processing now dispatches the SEP with a
TERMAPI.
2653313 (1090061)
EZASOKET applications are now tied to a single comms process for the life of a task. Previously, in the
event of termination of a comms process (if the process was not being used by an active EZASOKET
application), recovery would cause any active EZASOKET applications to dispatch the new comms
process on the next EZASOKET call (which would then fail) rather than the one it was already using.
2653313 (1090060)
When an enterprise server was processing a very large number of JCL jobs for the same class, a job
could be locked for dispatch in SYSZJOBD forever.
2617413 (1088420)
The EZ sockets SELECT and SELECTEX APIs now duplicate mainframe behavior in ignoring mask bits
that do not correspond to allocated descriptors. This means, for example, that SELECT can be passed
as a mask set to -1 (all bits set) to refer to any sockets the application has open.
2609555 (1087715)
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•

A problem with submitting jobs when "Local ES Security enabled" is checked for mfuser on the Users
page in ESMAC has been resolved.

•

2605873 (1087287)
Jobs active during shutdown are moved back to the input queue when the server restarts.

•

2588701 (1085584)
Previously, when retrieving the spool information, the text of some error messages has been truncated.

•

•

2582713 (1085017)
Logging has been added for the resource managers to facilitate recovery from failures that leave the
resource managers such as DB2 and MQ with in-doubt transactions. You only need to log if the
resource manager switch modules are configured to respond to xa_recover() calls. Logging may affect
the performance so you can disable it as follows - edit the server from the Enterprise Server
Administration, click the General tab and type the following in the Configuration Information text box:
[ES-Environment] ES_XA_LOG_SUPPRESS=Y
2582570 (1085539)
If you define an XA resource definition in MFDS for MQSeries, you must deselect IBM MQ in the SIT
definition in ESMAC, otherwise you will get a -5 error when the XA Switch is used.

CAS Security
Back to the list
•

•

•

A "redundant" or "high-availability" mode is now available in the Enterprise Server External Security
Facility. It enables you to configure multiple equivalent Security Managers and let processing continue
as long as at least one Security Manager is available. To enable this feature, add the following to the
configuration text area for the security configuration (either in the default Enterprise Server Security, the
MFDS Security, or on the Security tab for a specific enterprise server): [Operation] redundant=yes
2646298 (1089343)
Previously, when using IMS with LDAP-based security, the system could sometimes stop processing
requests for four minutes, and then issue a series of messages in the console log to indicate that
threads had timed out waiting for a thread lock. The system would then generally recover and start
processing again.
2640581 (1089108)
The fix for this RPI addresses the following specific situations:
1. Installation with an ESM that is not case sensitive for user IDs (for example - when sysad, SYSAD,
SysAd and other case combinations are all recognized by the ESM as the same user).
2. Installations where all user IDs are of a the same case - either uppercase or lowercase.
3. Installations where the user IDs are of mixed case and you would like to suppress any additional
ESM authorization attempts for keying errors.
4. Only ESM-backed security is affected.
You can now use the environment variable "ES_ESM_IDPW_CASE=xy" where "x" = user; ID case and
"y" = Password case. The values for "x" and "y" are:
•
•
•

U = Always uppercase
L = Always lowercase
M = Mixed case and case sensitive

When this environment variable is set, Enterprise Server will only make one attempt to identify a user
presenting the user ID and password as is (M), folded to uppercase (U) or folded to lowercase(L). If this
environment variable is not set, the legacy Enterprise Server behavior will be used. For the legacy
behavior for CICS, the User ID and the password are used as supplied possibly filtered by the
uppercase translation configuration of the sign-on transaction. For the legacy behavior for ESMAC and
IMS you have the following sequence - first, the user ID and password are used as supplied. If the
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authentication fails, the User ID is folded to uppercase and used again. If this fails as well, both the user
ID and the password are folded to uppercase and the used.
•

•

•

•

•

2640427 (1088819)
For Enterprise Server External Security, the MLDAP ESM Module now supports retrying the connection
to the LDAP server if it fails to connect. This provides some fault tolerance if the server is not
immediately reachable. See the MLDAP ESM Module documentation for more information.
2619088 (1088485)
When using an External Security Manager (ESM), an IMS printer no longer passes authorization
incorrectly when it is unknown to the ESM.
2617526 (1088978)
When the LDAP-based security has a long timeout (over four minutes) configured for LDAP operations,
the ESF Manager now increases the timeout for thread locks accordingly so thread locks do not expire
prematurely while the MLDAP ESM Module is waiting for a slow LDAP server.
In Enterprise Server's External Security Facility, the MLDAP ESM Module normally attempts to set a
user's failed-login count and last-login-time if the user class includes the associated LDAP attributes
(microfocus-MFDS-User-LoginAttempts and -LastLoginTime). You can now disable this from the
Security Manager configuration. See the documentation for the MLDAP ESM Module for more
information.
The cas-to-ad utility, which is used when initially configuring LDAP-based security for Enterprise Server,
now picks up the correct path for the default location of the CICS resource definition file (dfhdrdat).

CAS XA Switch modules
Back to the list
•

•

If a ROLLBACK is already in operation when an XA ROLLBACK is requested, Enterprise Server sees
the rollback as being successful.
2653121 (1089931)
The XDB XA switch module was updated to add a missing variable definition which prevented
compilation.
2638370 (1088599)

CCI TCP/IP
Back to the list
•

•

CCITCP now supports more than 4000 clients per server process on UNIX systems. CCITCP's memory
consumption with large numbers of clients should also be reduced, compared with previous releases.
2589460 (1089134)
CCI has been extended to allow the user to tune the content and location of first failure error messages
produced by CCI. This is controlled by the errlog_path option in the cci.ini configuration file.
2083845 (1053206)

Compiler
Back to the list
•

•

Programs with data names containing certain DBCS characters now compile as expected. Previously,
they would incorrectly report error message "COBCH0005 User-name not unique.".
2663436 (1090882)
VALUE clauses on THREAD-LOCAL data items are now always correctly initialized on a per thread
basis.
2659874 (1090647)
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•

•

Debugging with Expression view expanded to show many qualification levels of a data record no longer
causes the IDE to crash.
2659532 (1090682)
A MOVE of a numeric literal to a JUSTIFIED RIGHT data item now executes as expected.

•

2658757 (1090641)
The MOVELENCHECK directive now also includes checking when the source item is an alphanumeric
literal.

•

2656595 (1090311)
When compiling with DIALECT"ACU", a comparison between a numeric item and the figurative
constant NULL now works as expected.

•

2653033 (1089923)
Comp-1 data items are now processed correctly under DIALECT"RM". Previously, they were treated as
binary floating point items.

•

2652327 (1089892)
Preprocessors now work as expected with the DIALECT"ACU" compiler option.

•

2649324 (1089577)
The DIALECT(RM) directive now sets PERFORM-TYPE(RM).

•

2647147 (1089366)
Large EXEC statements containing DBCS characters now compile without error.

•

2645584 (1089204)
List file output with the DATAMAP directive is now shown correctly for SJIS data names.

•

2643308 (1088962)
The DBCS hyphen character x"817C" is now treated as occupying the correct number of column
positions, and so prevents spurious compile errors for comments in Area C.

•

2642431 (1088863)
Programs using ACUCOBOL-GT index names now execute as expected.

•

2641124 (1088755)
A VALUE clause on a national data item that specifies a figurative constant now works as expected.

•

2640826 (1088820)
An "out of memory" error when compiling ACUCOBOL-GT programs with both COPY REPLACING and
REPLACE statements has been fixed.

•

2640304 (1088671)
$DISPLAY of SJIS characters now works as expected.

•

2640050 (1088644)
Tab characters on the same line as DBCS characters no longer cause margin issues.

•

2638792 (1088607)
The maximum number of extensions supported by the COPYEXT directive has been increased to 25.

•

2618274 (1088353)
Literals assigned to DBCS data items are now checked for valid content.

•

•

2618240 (1088339)
When running under RM/COBOL or ACUCOBOL-GT emulation, appropriate declaratives are now
executed for an unsuccessful DELETE FILE operation.
2616717 (1088313)
The emulation of RM/COBOL has been improved regarding the default encoding of numerics types.
2607368 (1088045)
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•

Preprocessor-generated error messages now appear correctly in the Eclipse IDE.

•

2603384 (1087029)
The error message for when special register names are used as data-names has been improved.

•

•

2599694 (1086646)
A qualified reference to a paragraph in another section followed by an unqualified reference to the same
paragraph now compiles without error.
2598461 (1086498)
Display statements are now displayed correctly when using the window1 preprocessor.

•

2591903 (1085826)
A syntax error is now produced if you attempt to use a data item with more than 18 numeric positions in
extended ACCEPT/DISPLAY syntax.

•

2590649 (1085688)
The COPY statement no longer requires Katakana characters in a copybook's name to be enclosed in
quotation marks in order for the copybook to be found.

•

2582689 (1085009)
With regards to file handling, the DIALECT(RM) compiler directive now better emulates the default
behavior of the latest RM/COBOL product.

•

2582096 (1084955)
An error with EXTERNAL files where the fd name is the same as the name of an OS function (e.g. sin
or strcpy), which caused an rts error 114, has been fixed.

•

2492339 (1077479)
An error in ADD statements with multiple targets, where one of the targets has a subscripted subscript,
has been fixed.

•

2189318 (1062255)
Error messages 'RTS226 External file definition inconsistent' and 'RTS227 External data definition
inconsistent (Fatal)' have been enhanced to give additional information.

•
•
•
•
•
•

•

•
•

2188868 (1062214)
Parsing and consistency checking of the FOREGROUND-COLOR attribute in DISPLAY statements has
been improved.
The Compiler no longer crashes when processing the USE Compiler directive and the specified
directive file does not exist.
Under a Shift-JIS locale, you can now successfully compile a program containing tilde characters.
EXEC statements are now subject to the action of REPLACE statements (INCLUDE names excepted).
An INSPECT statement with both 'TALLYING .. FOR TRAILING ..' and 'REPLACING TRAILING ..'
syntax now compiles successfully and executes as expected.
The CHANGE-MESSAGE and HIDE-MESSAGE directives have been enhanced to allow non-severe
SQL and CICS errors to be configured (their severity changed or completely suppressed). This can be
achieved using the error message's 2-character sub-component prefix; for example, CHANGEMESSAGE(ES1000 N). If no prefix is specified, CH is assumed.
You now receive a warning when you use a TYPEDEF-NAME as a parameter for the PROCEDURE
DIVISION header of an ENTRY statement, except for external programs or program prototypes where
this syntax is legal.
The Compiler no longer crashes with an RTS114 error after finding multiple Report Writer syntax errors.
A error processing a bitwise logical expression that has a subscripted operand where the subscript is an
arithmetic expression has been fixed.

CICS: Problems not classed above
Back to the list
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•

The BMS Compiler message "BMSCH1064S Missing comma after operand with continuation,
continuation cards ignored" has been changed from a warning to a serious error and the return code is
set to indicate the error condition.
2639889 (1088636)

Cob/Cbllink/Cblnames (32-bit PC)
Back to the list
•

CBLLINK no longer gives an error when an object file is specified in a fully qualified path containing a
dot.
2605052 (1087384)

Data Tools Converter
Back to the list
•

DFCONV no longer fails on non-Intel byte order processors when the conversion uses an STR file.

•

2658596 (1090476)
Converting a Mainframe-Report-ANSI file to a PC-Print file where the file begins with a form feed no
longer results in a line feed being inserted in the PC-Print file before the form feed.

•

2652812 (1089911)
The Data File Converter no longer fails with DFC661 Error during conversion when executed in 64-bit
mode.

•

2649118 (1089569)
dfconv no longer fails with "DFC161 Error during conversion" if the profile file extension (.PRO) is not in
upper case on UNIX and Linux platforms.
2642112 (1088846)

Data Tools Editor
Back to the list
•

The Data File Tools editor no longer crashes when inserting a record after the last record of the file.

•

2655432 (1090160)
The Data File Tools editor no longer corrupts a PIC 9 data item when the field is edited from within the
record layout view.
2655011 (1090143)

Data Tools Layouts
Back to the list
•

Setting a condition value for a PIC 9 data item no longer displays a corrupt value.

•

2612439 (1087833)
Setting a condition value for a PIC 9 data item no longer displays a corrupt value.
2612152 (1087782)

Debugger
Back to the list
•

Stepping over the last statement of a paragraph of a program compiled with a mainframe dialect now
works correctly.
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2647563 (1089428)
Documentation
Back to the list
•

•

2593300 (1085893)
The documentation has been amended to alert users that under certain conditions, a dynamic binding
error is possible

•

2553077 (1082557)
You no longer need a 64-bit enterprise server in order to communicate with Microsoft BizTalk Host
Integration Server on a 64-bit machine.

•

2614060 (1087978)
The MFA installation process references a missing card image PDS file that can cause the MFAAS task
to fail the first time it runs. You should define this file, by creating it under TSO or by submitting JCL. For
example: //DEFVCTL JOB (MFA),MSGCLASS=A,CLASS=A,MSGLEVEL=1 //* //* Define Data Connect
VSAM mapping control //* // EXEC PGM=IEFBR14 // MFAVCTL DD DSN=<hlq>.MFAVCTL, //
UNIT=3390, // VOL=SER=volser, // DCB=(RECFM=FB,LRECL=80,BLKSIZE=6160), // SPACE=(CYL,
(1,1,25),RLSE),DISP=(,CATLG,DELETE) You must assign an appropriate high-level qualifier and select
the unit and volume names for where this file will reside. In addition, each site may assign storage class
options which comply with their data centre's standards.

•
•

2260128 (1065835)
The casrdtex documentation has been updated to include several more supported parameters.
The documentation has been updated to explicitly state that the "3270 Print" field must be defined as
"Y" if CICS printing is to be enabled.

•

2613401 (1087890)
The documentation has been updated so that the help page more accurately reflects the ESMAC
screen.

•
•

2611733 (1087753)
The documentation now includes information about the -stcpssl cassub option.
2605136 (1087060)
The product documentation now includes information about the ES_JESYSMSG_OUTPUT
environment variable.

•

2604533 (1087004)
The documentation has been updated to clarify the effect of escape characters on path names.

•

2594224 (1086013)
The CPMT transaction no longer supports the CEDF or NOCEDF functions.

•
•
•

2527592 (1089531)
The documentation has been updated to clarify the background information relating to JCL User Exits.
The documentation has been updated to clarify background information related to JCL User Exits.
The documentation has been updated to remove references to ERRORLEVEL in UNIX environments.

•
•
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The documentation was not clear about the range of acceptable values of EX_XA_????_NB_RETRIES
or the consequent system behaviours. This has been corrected.

2610423 (1087575)
The documentation has been updated to provide more information about the MFJAMS LISTCAT
command.
When invoking MFSORT from the command line, the maximum length of the command is 1024
characters. Characters after this limit are ignored, and if this truncation causes an invalid/incomplete
command, an error is produced.
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Eclipse - Debug
Back to the list
•

The process being debugged will no longer hang when there is an error in the JCL code after a Stop
Debugging request.

•

2651928 (1089990)
The contents of the COBPATH environment variable are now picked up correctly when debugging.

•

2641660 (1089106)
Eclipse no longer exits with a Run-Time System error 153 during remote debugging.

•

2616122 (1088263)
On Windows, JIT debugging no longer fails to attach to the process being debugged.

•

•

2614145 (1088667)
Debugging multiple programs while there are items in the Expression View no longer results in the
Eclipse IDE closing when the program changes.
(595485)
The value of variables shown by the debugger was truncated by LOW-VALUE characters. It is now
possible to modify variables containing LOW-VALUES only in the Hex mode of the Change Value
dialog.
(595390)

Eclipse IDE
Back to the list
•

The items in COBOL Explorer are now ordered using the whole file name rather than using the suffix
and then the rest of the name.

•

2653659 (1089996)
Trying to open a COBOL file from the CVS Repositories view resulted in the tree view display becoming
corrupted and the editor was not displayed.

•

2652853 (1090200)
The COBOL Copy view no longer shows corrupted text when the replacement text was shorter than the
text it replaced.

•

2652219 (1089888)
File level SQL settings can now override project level SQL settings.

•

2647596 (1089619)
You can now start debugging after choosing a different program name or launcher in a Remote COBOL
Application debug configuration.

•

2647181 (1089402)
The error markers in the current project are now correctly removed when all errors in projects upon
which the current project depends are fixed.

•

2646469 (1089305)
list files generated for the IMS files in your project are now produced in subfolders of the Listing
directory of the project.

•
•

2640473 (1088709)
Double-clicking an error in the Problems view in Eclipse now opens the correct file.
2610500 (1088142)
Typing '*' in column 1 in the editor for applications that use a mainframe dialect no longer comments out
the line.
2608522 (1087593)
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•

•

•

•

The performance of the background syntax checking has been improved so it does not slow down the
debugger.
2606836 (1087240)
Background parsing of programs in remote projects would sometimes fail to complete if a COBOL
Editor window was open when Eclipse was started.
2605902 (1087319)
The .cobolBuild file now includes properties to control the fails on error. From the command line, you
can set the value of these properties to true in order to make Ant abort the build at the first error. Use
the general property "failOnError" if you need to abort on errors in any file types - COBOL, cobollink, lbr,
bms, ims. The following properties control failing on error in the specific file types: cobolFailOnError,
cobollinkFailOnError, lbrFailOnError, bmsFailOnError, imsFailonError. Note that lbrs cannot be created
through Enterprise Developer but only using Visual COBOL.
2587325 (1085781)
COBOL Copy view no longer shows corrupted text if there were REPLACE statements that introduced
additional source lines.

•

2586983 (1085408)
Previously configured remote connection details are now preserved when you restart Eclipse.

•

2575926 (1085613)
The remotedev scripts now allow you to have a default shell of /bin/csh.
2571165 (1088947)

File Handling - External File Handler
Back to the list
•

•

•

•

•

•

•

For SORTIN, all data sets in a concatenation must use the same RECFM - either all fixed-length or all
variable-length. Also, if using fixed-length records, LRECL must be set the same for all data sets.
2654517 (1090095)
A COMMITFLUSH no longer causes file corruption. Previously, corruption was possible with
COMMITFLUSH on when a process, having done only a rewrite that changes non-key data, is
committed after another process has altered the files size.
2652378 (1090281)
The RM RECOVER1 utility is now distributed with Enterprise Developer in case RM indexed files need
to be recovered or rebuilt.
2650917 (1090175)
Support has been added for the ASSIGN TO PRINT syntax when accessing RM/COBOL data files.
Specifically, BEFORE ADVANCING <count>, AFTER ADVANCING <count>, BEFORE ADVANCING
PAGE, and AFTER ADVANCING PAGE now work correctly and produce the same print file contents as
they do in RM/COBOL.
2649809 (1089792)
The RM/COBOL configuration option
RMFM_RUN_INDEX_FILES_DEFAULT_FILE_VERSION_NUMBER 2 now correctly creates a version
2 RM/COBOL indexed file.
2649414 (1089679)
A SORT action no longer fails due to an illegal filename when the SORTTEMP file is specified to be an
RM file using EXTFH.CFG.
2648865 (1090292)
File names containing embedded spaces now work correctly in XML Extensions.
2648306 (1089486)
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•

•

•

•

•

The correct file status "23" is now stored in the file status data item, which will cause the proper
INVALID KEY condition action for REWRITE RANDOM or DELETE RANDOM I/O operations on an
RM/COBOL data file.
2648182 (1089461)
A WRITE or REWRITE operation on a fixed record length RM/COBOL or ACUCOBOL-GT file no longer
generates an erroneous 44 error after a READ of a short record.
2647143 (1089369)
DELETE and REWRITE operations on an RM/COBOL indexed file with DYNAMIC access and where
the prime key allows duplicates now work correctly, meaning that the behavior matches RM/COBOL,
where the operation behaves like sequential access and deletes or rewrites the current record.
2646274 (1089289)
When opening an RM/COBOL data file for input, a READ WITH LOCK after a READ WITH NO LOCK
no longer returns an erroneous 99 (record locked) error. This matches RM/COBOL behavior for a file
opened in the input mode.
2644830 (1089726)
When accessing RM/COBOL data files, a file status of 04 is correctly returned where appropriate.

•

2616717 (1088310)
When accessing RM/COBOL data files or calling C$RERR, file statuses '44,03', '44,04', and '44,07' are
correctly returned where appropriate.

•

2616717 (1088465)
When accessing RM/COBOL data files or calling C$RERR, file status '47,01' is correctly returned where
appropriate.

•

2616717 (1088467)
When accessing RM/COBOL data files or calling C$RERR, file status '48,01' is correctly returned where
appropriate.

•

2616717 (1088468)
When accessing RM/COBOL data files or calling C$RERR, file statuses '93,02' and '90,05' are correctly
returned where appropriate.

•

2616717 (1088469)
A file status of 90,05 is now correctly displayed as 90.

•

2616717 (1088449)
C$RERR now reports a meaningful 30,22,nnnnn error, where nnnnn is the Micro Focus extended
status, when the File Handler diagnoses an operation error on an RM/COBOL data file.

•

2616717 (1088470)
File Handler now converts the charset of all instream data in a concatenated dataset to that of the
calling program.

•

2606382 (1087212)
The file locking for VB files with DISP=SHR has been removed. It is now the user's responsibility to
ensure that other users do not update the file at the same time.

•

2605857 (1087302)
EXTFH configuration options specified under the FOLDER tag now work correctly with UNIX files when
they are specified with an absolute path in the SELECT statement of a COBOL program.

•
•

2594733 (1086089)
Concatenating multiple SYSIN DD statements now works correctly.
2590465 (1085905)
File corruption no longer occurs when you make two rewrites of a record in the same transaction, where
the first rewrite changes an alternate key and the second rewrite changes it back again.
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•

2576793 (1084780)
CTF tracing no longer defaults to showing CTF handles as errors. CTF tracing for handles now only
appears for DEBUG and ERROR levels.

•

2566161 (1083551)
If the DDname is missing from JCL, the value of COBDATA is not used to search for a file.

•
•

2559292 (1084935)
The rebuild help message file has been updated to correct a typo.
Fileshare now supports the ACU and RM file formats.

File Handling - Fileshare
Back to the list
•

SORT no longer abends if the SORTIN file is a Fileshare file.

•

2653753 (1090002)
A commit-prepare now returns non-zero error code if the Fileshare server is not running.

•

•

2637773 (1088492)
If the Fileshare server crashes before a commit or a rollback in the two-phase commit, the transactions
before a commit-prepare are now committed while recovering the file.
2637773 (1088493)
Byte-stream routines called from Fileshare clients now work correctly with a 64-bit Fileshare server.
2607314 (1088601)

File Handling - Sort / JCL Sort
Back to the list
•

When a previous SORT operation had a larger SORTOUT, the next SORT now works correctly.

•

2661456 (1091272)
A SORT with OUTFIL SECTIONS no longer abends with an S0C4 error code.

•

2654272 (1090066)
Errors no longer occur when sorting large records with SORTCOMPRESS set to 5.

•

2654143 (1090038)
If the SORTSPACE or SORTTEMPSPACE environment variables are set outside of their documented
limits, a message is emitted in SYSOUT.

•

2651650 (1089880)
When SKIP=P is specified for a SECTION in an OUTFIL control statement, HEADER2 records are
correctly printed when the page breaks for the SECTION break.

•

2651125 (1089958)
Masking with III now correctly displays a space instead of a zero when the input is PD 000.

•

2650644 (1090020)
MFJSORT no longer abends if a physical file is missing when SORTIN is directed to DUMMY.

•

•

2647785 (1089487)
MFJSORT now support the use of FORMAT where some field types were already specified; for
example: SORT FIELDS=(1,3,A,5,3,CH,A),FORMAT=CH
2646265 (1089410)
The maximum number of SUM FIELDs allowed in a sort has increased to 600.
2646246 (1089405)

50

| Micro Focus Enterprise Developer 2.2 for Eclipse Release Notes

•

•

The length of the TOTAL field is now calculated correctly, using the value specified in the LENGTH
parameter.
2643037 (1088960)
Under ICETOOL emulation, the maximum size of an ON field for ZD data types has been increased
from 15 to 31 bytes to emulate mainframe behavior.

•

2641631 (1088811)
Support has been added for the SPLICE operator when using the DFSORT ICETOOL emulation.

•

2641128 (1088775)
DFSORT emulation now supports the DATEDIFF functionality.

•

2640737 (1088843)
Under ICETOOL emulation, the maximum size of an ON field for data type CH has been increased from
80 to 4000 bytes to emulate mainframe behavior.

•

2617590 (1088345)
SORT now correctly validates the file attributes of SORTOUT and any OUTFILs that are used with
FTOV.

•

2615463 (1088131)
MFJSORT now supports the format code FS when it is used as an input format in INREC and OUTREC
statements in JCL sort.

•

2612188 (1088012)
SORT now terminates with return code 16 and throws a 9/013 error when the catalogued input file is
not physically present.

•

2607690 (1087529)
SORT now terminates with return code 16 and displays error message "SORT103E Invalid
operator .JOINKEYS." when the JCL contains the JOINKEYS parameter.

•

2607369 (1087311)
A SORT RETURN statement now returns a 9/230 error for the return past EOF.

•

2606867 (1087358)
Support has been added for processing negative FI summary fields.

•

2604402 (1086996)
When running a mainframe SORT under certain circumstances, the LRECL for mainframe print files no
longer gets set incorrectly.

•

2600541 (1086632)
SORT now correctly abends when MFJSERET is set to ABEND.

•

2597115 (1086370)
SORT now terminates with an error RC=16 when the SORTOUT DD is missing from the JCL.

•

2594119 (1086423)
SORT no longer adds extra bytes to the output file when the SORT card includes either CHANGE or
NOMATCH options.

•

2589359 (1085677)
The ALLDUPS option of the ICETOOL emulation now correctly separates records with duplicates and
without duplicates.

•
•
•

2582219 (1085463)
Performing a check of the SORT FIELDS length against SORTIN record length is no longer needed if
the SORTIN physical file is missing.
The SECTIONS parameter now works correctly when using multiple OUTFILs in a SORT.
SORTOUT is no longer confined to OUTFIL processing.
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IDE Debugging
Back to the list
•

If you set the debug_on_error tunable to 1, then the debugger will now attach for all RTS errors.

IDE Mainframe Explorer
Back to the list
•

When starting a network connection test, the output pane now automatically gets in focus.

JVM - Compiler
Back to the list
•

•
•

•

•
•

Previously, a program using a MAX OR MIN function with an ALL parameter was generating bad code
when compiled for JVM.
2647112 (1089359)
Previously, you could receive some warnings for calls to the RM library routine C$GetEnv.
2601487 (1086710)
When compiling JVM COBOL, if the PERFORMTYPE directive is not set to the default value of mf, very
large programs sometimes do not compile. In such cases, 'COBCH1633 - Procedure division too large
or complex - try using performtype(mf)' is displayed. Compiling with performtype(mf) normally fixes the
problem.
2581224 (1084860)
In Windows environments, if a COPY statement specified a file name that was not in quotation marks,
or did not include the full extension, then setting a breakpoint in that copy file was not always
successful.
2577765 (1084637)
Copy statements that reference a file whose path contains spaces no longer cause errors.
2577765 (1086750)
Previously, the JVM Compiler did not recognize COBOL static inner classes (that is - nested classes
without a SHARING PARENT, or nested classes produced using ILSMARTNEST).

JVM - RTS
Back to the list
•

•
•

When using JVM COBOL with Apache Tomcat, you no longer see warning messages from the
org.apache.catalina.loader.WebappClassLoader checkThreadLocalMapForLeaks class relating to
classes in the package com.microfocus.cobol and below.
2612595 (1088144)
When creating a debug configuration for a JVM COBOL application, superfluous classes are no longer
listed on searching for a Main class.
Previously, when a thread called a subprogram with thread-local storage it might have intermittently got
reset when creating many threads quickly.

Macro Preprocessor
Back to the list
•

SYSVERSION is supported by the macro preprocessor.
2549363 (1082124)
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MF Common Client
Back to the list
•

•

A problem with the Micro Focus Common Client not supporting 64-bit COBOL programs on UNIX and
Linux has been fixed. This enables ECI functionality for 64-bit COBOL programs, and may correct
issues with certain other features such as Web Services clients.
2642116 (1088854)
When there are multiple directories configured in mf-client.dat, the service deployment tools (such as
imtkmake) and the IDE features now correctly scan all directories for deployment destinations and not
only the first one.

MF Communications Server
Back to the list
•

•

•
•

•
•

In EZASOKET/EZACICAL applications, the "reserved" portion of the socket-address information
returned by API calls (such as GETSOCKADDR and GETPEERADDR) is now set to low-values, for
improved mainframe compatibility.
2659699 (1090549)
You no longer receive a run-time system error when an invalid IMS Connect message is received with a
missing end-of-message indicator.
2649746 (1089727)
A problem causing IMS Connect conversations to an enterprise server to hang has been resolved.
2645771 (1089247)
For SSL-enabled listeners in Enterprise Server, MFCS now offers the option of setting SSL keyfile
passphrases using a user exit module. For instructions and a sample module, contact Micro Focus
SupportLine.
2641670 (1088950)
Intermittent failures in the CICS Web Interface servers that send chunked responses have been fixed.
The SO_LINGER socket option in CICS sockets (EZASOKET / EZACICAL) now works correctly.

MF Directory Server
Back to the list
•

In the Enterprise Server Administration HTML GUI, clicking "Update All" on the Security Manager List
page while an enterprise server instance using external security was started would cause the MFDS
process to terminate.

•

2654069 (1090069)
The MFDS XML import command line option correctly sets the value of the listener's SSL client
authentication option on import.

•

2653699 (1090115)
The MFDS command line options to export or import server configuration data when using an external
Security Manager now work correctly.

•

•

2652779 (1089981)
If the custom configuration text for an Enterprise Server instance was larger than 4K and the "Create
XML repository copy" repository option was selected or, if the server configuration was exported in XML
format, the MFDS process could terminate.
2650330 (1089683)
The MFDS -x and -g command line options for creating and importing Enterprise Server instance
configuration in XML format can now be run against an MFDS process running on a specific TCP
address and port by using the CCITCP2 and CCITCP2_PORT environment variables.
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•

2646427 (1089303)
The correct details for Enterprise Server "MSS Inter-System Communication" conversation type
listeners can now be exported and imported using the MFDS XML export/import feature.

•

2644237 (1089091)
The "Directories" link in the Enterprise Server Administration GUI did not function correctly based on the
configured Security Manager permissions for a logged on user.

•

2583624 (1085073)
When you use casstart from the command line to start an enterprise server instance that appears as
"Not Responding" in the Enterprise Server Administration, the status log for that server is now cleared
when the server reaches "Started" state.
2570318 (1086170)

MFA: GUI components
Back to the list
•
•
•
•
•
•
•
•
•

MFAVCTL is now supplied with the MFA installation.
2591556 (1085784)
Issuing MFDAS DIR PAN dsn FILTER * ALL no longer results in an compressed output.
Changing your password or phrase using the ME logon dialog now works.
The MFA server will no longer abend if a user tries to change a password to a passphrase and vice
versa.
MFDAS exports of files with spaces in their names to VB format QSAM data sets no longer produces an
empty file.
MFDAS STATUS FILTER * will now work correctly with the latest MFA servers.
The data set context menu now has a Properties item.
MFA CATDCB displays now correctly list DA data sets.
MFA clients will now be able to determine if Changeman is installed on the mainframe and will modify
dialogs appropiately.

MFA: Mainframe
Back to the list
•

•
•

The MFA GUI components have been updated to support 20-byte pass phrases which are now
validated by the server. The following new server configuration option that enables passphrase support
is now available: MFA_GUI_ACCEPT_PASSPHRASES=YES
2524253 (1080571)
You can now select a particular SYSOUT dataset by specifying the dataset name. The output from DIR
JESDD displays has been enhanced and jobname filters may be used with the STATUS option.
Large binary uploads sometimes resulted in some data corruption.

MFBSI
Back to the list
•

If a huge number of jobs are submitted by the scheduler in a short period of time, some MFBSIJCL
instances may end with an error RC 244. To work around this issue, use the new MFBSI.CFG
parameter "EMX-Timeout=nn" to increase the default timeout interval of 5 minutes to a longer interval
(10 or 15 minutes). This allows all job conclusion tasks to complete.
2608309 (1089075)

MTO - CICS BMS Screen painter
Back to the list
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•

Compiling a BMS map now generates a COBOL copybook with PIC G data items if DBCS is defined
using PS=8 or PS=X'F8' for the field macro.

•

2614393 (1087970)
Compiling a BMS map now generates a COBOL copybook with PIC G data items if DBCS is defined
using PS=8 or PS=X'F8' for the field macro.

•

2605849 (1087131)
You no longer receive an error message when compiling COBOL language BMS files if a PICOUT
string in them contains the character "0" (zero).
2591902 (1085804)

MTO - CICS ECM/Preprocessor/Translator
Back to the list
•

The figurative constant ZERO together with its variants is now recognized as a parameter in a CICS
command.
2663191 (1090846)

MTO - CICS Emulation
Back to the list
•

Using CALL and LINK statements to the same CICS program multiple times within the same task no
longer causes an RTS 200 error. Note that mixing CALL and LINK statements to the same program can
cause an incorrect RESCOUNT.

•

2642963 (1089521)
EIBRCODE is now returned correctly following an EXEC CICS START command.

•

2616152 (1088292)
The documentation now clarifies the usage of DDnames in the SSTM context.

•

2593338 (1085948)
EXEC CICS ASSIGN USERNAME will now return spaces, as the username information is not held
anywhere in either the resource definition files or the ESM.
2583351 (1085968)

MTO - CICS ESMAC
Back to the list
•

•

•

In the Spool display, the number of lines displayed is now kept in sync with the current selection even if
the page is refreshed using the browser refresh button.
2608719 (1087732)
The "Home" link in the ESMAC HTML page now correctly links back to the Enterprise Server
Administration HTML GUI page if SSL is being used for the browser connection to both GUIs.
2526354 (1085186)
The Refresh button at the bottom of the ESMAC page now works correctly.
(595265)

MTO - CICS Utilities
Back to the list
•

A BMS field name is no longer replaced with a default unique name when BMS GT options are enabled
and the BMS field name is shorter than 3 characters.
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•

2615161 (1088123)
The size of the variable used to parse the commands you enter at the command line has been
increased to more than 255 characters.
2572053 (1084087)

MTO - IMS DB
Back to the list
•

•

Previously, the casout command was unable to display output from /DIS DB commands when the
output contained one or more blank lines.
(586190)
An ISRT call that results in a DEADLOCK and is subsequently chosen as the DEADLOCK loser failed
to return an FD status code.
(598691)

MTO - IMS ESMAC
Back to the list
•

Using the ESMAC /DIS TRAN ALL and /DIS USER ALL buttons no longer fails unexpectedly with an
RC=24 message.
2644785 (1089181)

MTO - IMS TM
Back to the list
•

An MPR running a Wait-for-Input transaction no longer sporadically gets stuck and incorrectly marked
as busy.
2651114 (1089764)

MTO - IMS Utils
Back to the list
•

The IMS DB editor no longer fails with a run-time system error 173 on the "mFHTSRtr" file.

•

(593399)
Previously, a /STOP DB command might have been causing an infinite loop in the JES initiator that
invoked it.
(595100)

MTO - JCL ESMAC
Back to the list
•

A problem where Japanese letter appeared corrupted in SPOOL view has been resolved.

•

2664435 (1090962)
Dynamic PDS member names starting with "$$" were not displayed in the catalog view.

•

2652384 (1089877)
You no longer receive a Script Errors window, with Enterprise Server in Internet Explorer (with "Display
a notification about every script error" turned on in Advanced Options) or from within Enterprise
Develiper for Visual Studio 2010, when you navigate to ESMAC and select JES/Catalog.
2598615 (1086461)
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•

The errors in the EBCDIC characters displayed in the ESMAC Spool and Catalog page have now been
corrected. If a character is not displayable, it will be displayed as a '.' in ESMAC. Viewing the file in a
DATA VIEWER should display the characters as expected. However, it should be remembered that
ESMAC should not be used as a DATA VIEWER tool.
2551170 (1085713)

MTO - JCL MVS
Back to the list
•
•

A PC file is now created when allocating empty datasets with DISP=(NEW,PASS) set.
2647864 (1089720)
The JCL lexical files, produced when parsing a JCL Job stream, are not compatible with previous
versions of this product. This only affects jobs that may be restarted. Such jobs may not be restarted if
originally run in an earlier version of the product. Trying to restart them produces JCL errors.
2644393 (1090222)

MTO - JCL System Catalog
Back to the list
•

•

In certain circumstances a job could complete normally without the return code displaying in the
ESMAC output spool view. This has been fixed.
2607769 (1087362)
The referenced data in the catalog entry for a pds model is now updated whenever the catalog entry for
any of its members is updated.
2581611 (1084905)

MTO - JCL TSO
Back to the list
•

The documentation has been updated to clarify the IDCAMS commands available within TSO batch
jobs.
2573281 (1084163)

MTO - JCL Utils
Back to the list
•

A header is now created for an empty VB file when the environment variable MFALLOC_PCFILE is set
to Y.
2648281 (1089537)

MTO - JCL Utils - IDCAMS
Back to the list
•

•

The IDCAMS REPRO of records into an RRDS file that already contained data was generating a file
write error. This has been corrcted. If the RRDS file contains records and REPLACE has been specified
in the REPRO command then the records will be overwriten. If REPLACE has not been specified then a
DUPLICATE RECORD (JCLAM0236E) error will be generated.
2601984 (1086780)
If the pc file associated with an empty unopened VSAM dataset was populated outside of JCL, the flag
on the catalog remained set to empty. The record count is now checked, and if this is not 0, the empty
flag is switched off.
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2561933 (1083277)
MVS REXX Emulation
Back to the list
•

•

The REXX engine previously assumed that all hexadecimal strings represented EBCDIC characters.
This resulted in the X2C built-in function producing an incorrect result when a hexadecimal string
representing ANSI data was used. The MFREXX_CHARSET environment variable can now be used to
indicate whether the REXX engine should use EBCDIC or ANSI when working with hexadecimal strings
or performing string comparisons.
2647920 (1089596)
Trace options set in a parent procedure are now propagated to a CALLed internal procedure.

•

2612317 (1087818)
Execs residing in temporary datasets allocated to SYSEXEC or SYSPROC no longer sometimes fail to
load.

•

2579785 (1086478)
The LASTPOS function no longer returns an incorrect result if the 'start' parameter value exceeds the
length of the 'haystack' parameter.

NCG
Back to the list
•

You no longer receive an RTS 114 error when stepping EXEC SQL statements in debug mode.

•
•

2611568 (1088003)
A bug in "display ... upon environment-name" with the [NOT] ON EXCEPTION clause has been fixed.
A bug that affected querying linkage items in a program that has parameters in working-storage has
been fixed.

Open PL/I CICS Preprocessor
Back to the list
•

Accented characters with a code of 'ef'x are now supported.

•

2653232 (1091079)
This RPI resulted in new feature documentation for the new PLICNV utility, rather than a readme entry.

•

2581884 (1085022)
When a nested %INCLUDE is preprocessed by the macro preprocessor, the corresponding %ENDFILE
is now injected into the preprocessor output in the correct column (column 1).
2546061 (1082294)

Open PL/I Compiler
Back to the list
•
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A problem no longer occurs when assigning Picture to Fixed Decimal with zero scale and differing
precisions.

•

2665723 (1091114)
When a CHAR data item uses the POSITION attribute as part of an illegal DEFINE, the Open PL/I
Compiler now uses BYTE units to calculate the POS offset rather than the base variable's size units.

•

2661472 (1090693)
Declaring a named constant as type CHAR VARYING now correctly raises an error. The VALUE
attribute is ignored in this case.
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•

•
•

2659096 (1090511)
The Open PL/I Compiler no longer produces erroneous diagnostics due to the loss of fractional digits in
fixed decimal arithmetic.
2658646 (1090473)
Using the SUM, ALL, ANY, or PROD built-in in an initial clause no longer causes a compiler abort.
2658113 (1090424)
The COPY built-in no loners encounters a performance issue when the specified string and number of
times to copy is greater than or equal to 32765.

•

2657699 (1090387)
A compiler issue no longer occurs when processing AREA of storage class BASED.

•

2655714 (1090180)
Multi-edit PUT STRINGs now work correctly on all platforms.

•

•
•

•

2654555 (1090113)
Using FETCH on a function declared without OPTIONS(FETCHABLE) no longer raises compiler error
message MFPLI02000A.
2654320 (1090071)
The Open PL/I Compiler no longer raises an error when converting a type PIC to BIT(1).
2653666 (1089989)
The Open PL/I Compiler no longer abends with an error when named constants of type PICTURED are
used.
2653250 (1089963)
The Open PL/I Macro Preprocessor now correctly generates lines greater then 256 characters.

•

2653116 (1089932)
A problem with producing extra trailing zeroes when moving PIC items no longer occurs in the Open
PL/I run time.

•

2651507 (1089939)
Passing a function name with an empty parameter list as an argument to a subroutine or function call is
now treated like a function invocation (unless type ENTRY is specificed in the parameter descriptor).

•
•

2651414 (1089761)
A problem no longer occurs when converting a fixed point binary constant to type BIT.
2650756 (1089721)
A run time SIGSEV error whe using a conditional AND and OR with structure member refeences no
longer occurs.

•

2649990 (1089644)
Using TRIM(TRIM()) no longer produces incorrect results.

•

2649021 (1089553)
Combining the VERIFY() and TRIM() built-in functions no longer gives an incorrect result.

•

2647769 (1089432)
AREA sizes greater than 32K are now allowed. The implementation limit of the compiler and runtime is
2 Gigabytes. Note that very large AREA sizes may be impacted by system resources.

•

2646608 (1089309)
Using a function invocation without parentheses returning pointer no longer causes a compiler error.

•

2646126 (1089263)
mfpli no longer generates illegal instructions for some complex PUT statements.
2644311 (1089089)
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•

•

A PLIDUMP and Codewatch issue displaying char varying data items no longer occurs when using the bigendian compiler option.
2643377 (1089259)
Severe error MFPLI00092S no longer occurs when using the STG or SIZE built-in on a based variable
without a locator.

•

2642953 (1088914)
Decimal rounding now generates the correct code.

•

2642571 (1089083)
Comparison operators for named constants now function as expected.

•

2641149 (1088758)
A problem passing a CHAR VAR parameter no longer occurs when using the -zp1 compiler option.

•

2641060 (1088916)
A problem with relational comparisons between OFFSET variables and the NULL built-in no longer
occurs when the compiler option -setnull 0 is not used.

•

2618457 (1088544)
A problem with the POINTER built-in returning -1 no longer occurs when the first argument is a NULL()
offset reference and the compiler option -setnull 0 is used.

•

2618457 (1088527)
The built-in functions OFFSETADD, OFFSETSUBTRACT, OFFSETDIFF, and OFFSETVALUE are now
supported.

•

2616735 (1088217)
When initializing fixed decimal static arrays, an erroneous 343E diagnostic message with regard to
precision and scale was being issued.

•

2609295 (1087452)
Named constants of type BIT with static initializers no longer has a regression issue.

•

2607316 (1087296)
An issue which resulted in a SIGSEGV during the code generator phase of the Compiler has been
resolved.

•

2607092 (1087283)
The Open PL/I Compilker no longer encounters a problem using a CHAR(*) VAR parameter as the
argument to the MAXLENGTH built-in.

•

2606704 (1087241)
Any varaible declaration with conflicting storage attributes now produces and E-level diagnostic. The
Open PL/I compiler accepts the first storage attribute and ignores any additional storage attributes.

•

2605852 (1087130)
Parameter declarations with a CHAR length given by the CSTG, STG or LENGTH builtins is now
supported.

•
•

•

2605672 (1087148)
A problem with a function call in the RETURN statement has been fixed.
2605508 (1087098)
The Open PL/I Compiler now evaluates restricted expressions on RETURNS descriptors in entry
declarations.
2605506 (1087097)
An issue with using SUBSTR of a character pictured variable as a pseudo-variable has been resolved.
2603607 (1086979)
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•

For the Open PL/I Compiler, the implementation limit of 64 for the number of data and format list pairs
in an edit-directed specification has been increased to 256.

•

2600690 (1086769)
An erroneous diagnostic for fixed decimal variables accepting the specified number of digits has been
fixed.

•

2600689 (1086830)
The Open PL/I Compiler now correctly handles bit variables with DEFINED storage and the POSITION
attribute.

•

2600658 (1086738)
An issue with using the NULL and SYSNULL built-ins in a named constant VALUE expression no
longer occurs.

•

2599747 (1086545)
Using the DIM builtin as part of a restricted expression evaluation in declarations has been fixed.

•

2599097 (1086516)
Using INITIAL clauses that contain concatenation of string constants were generating compiler errors.

•

2598242 (1086434)
The string concatenation of the HIGH/LOW built-ins with a repeat factor no longer returns incorrect
results.

•

2597746 (1086379)
A problem when using the STRING function as a pseudo-variable and the Compiler switch -range has
been fixed.

•

2597682 (1086550)
When the Regional Language setting for the decmial point was a ccmma (for example 3,141592), a
possible floating point conversion error from ASCII to float binary occurred.

•

2593986 (1085970)
The TINY and HUGE Open PL/I built-ins are now supported.

•

2592830 (1085870)
An incorrect padding of trailing blanks occurred for a string returned by the expression
HEX(SUBSTR(...)).

•

2590174 (1085658)
A possible memory leak in -opt mode no longer occurs when using character strings in a relational
comparison.

•

•

•

•

2587143 (1085402)
Beginning with Enterprise Developer 2.2, short-circuiting of IF statements occur independent of the
optimizer at all -opt levels including -noopt, which means you should not encounter optimization warning
diagnostics.
2553574 (1086481)
Previously PL/I Programs which contained FIXED DECIMAL variables that required a precision > 18
would not compile and execute successfully in Enterprise Developer. Open PL/I Programs can now
support a FIXED DECIMAL precision of 31 or less.
2549420 (1082138)
A FIXED BINARY named constant with a value clause that uses the BX format no longer produces a
compiler error.
2521502 (1079751)
The VALIDDATE built-in is now supported.
2467971 (1075530)
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•

•
•

•
•
•
•
•
•
•
•

An Open PL/I Program that previously could not be preprocessed by the macro and SQL preprocessors
no longer compiler incorrectly or with errors.
2467964 (1075506)
The VALUE clause in named constants has been enhanced to support the POINTERVALUE built-in.
An erroneous result no longer occurs when assigning a PICTURE, FIXED DECIMAL, where the fixed
decimal item scale is equal to 0, the FIXED DECIMAL item precision is equal to the PICTURE item
scale and the PIC item has no significant digits.
The -nodebuginfo option is now available when using mfplx to invoke the macro preprocessor.
A problem with passing an unaligned variable to the HEX built-in has been fixed.
The Open PL/I Compiler now supports the PARAMETER attribute.
The Open PL/I compiler now supports hexadecimal (XN) fixed binary constants.
The Open PL/I Compiler now supports the NOINIT attribute.
The Open PL/I Compiler now diagnoses CLOSE FILE(*) as not yet supported.
The CLOSE FILE (*) statement is now supported.
The -map compiler option now shows pad bytes inserted for alignment between structure members.
This applies only to pad bytes inserted between structure members which have a constant offset from
the beginning of the structure.

Open PL/I Compiler Back-End
Back to the list
•

You no longer receive an error 211, "Assignment of arrays or structures is only valid if both sides of the
assignment have identical size, shape, and component data types".
2355413 (1069925)

Open PL/I Debugger
Back to the list
•

•
•

•
•

A problem with PLIDUMP abending that was caused by variable-sized structure arguments on the stack
frame no longer occurs.
2650211 (1089995)
The warning message "stb is newer than executable file" in CodeWatch no longer triggers inaccurately.
2611268 (1087655)
Codewatch correctly starts a debugging session on the application program's PROC statement rather
than the CICS "start-up" code.
2609009 (1087685)
A problem evalualting CONTROLLED variables in the Open PL/I Debugger has been fixed.
2578290 (1085303)
CodeWatch now correctly debugs into procedures included using a %INCLUDE statement which is
nested inside of another procedure.
2572827 (1084459)

Open PL/I Macro Preprocessor
Back to the list
•

Variable values are no longer incorrectly passed to the macro preprocessor when the macro
preprocessor uses variable as a parameter and the closing parenthesis immediately followes the
preprocessor variable name.
2655735 (1090181)

62

| Micro Focus Enterprise Developer 2.2 for Eclipse Release Notes

•

The macro preprocessor no longer terminates abnormally or loses code if certain NLS are embedded in
literals or comments.

•

2653232 (1089946)
Previously, if a %ENDFILE; was embedded within an EXEC SQL statement, the EXEC SQL
preprocessor, mfexecpp, would not precompile the application successfully.

•

2641151 (1088759)
When compiling complex PL/I programs with multiple %INCLUDE files at multiple levels which utilize
macro logic, an abend no longer occurs when passing -nodebuginfo to the macro preprocessor.

•

•

•

•

•
•

•
•

•

2640069 (1088712)
A warning no longer generates when REORDER is used a parameter to a macro, and REORDER;
appears in the same place as a keyword parameter to a macro as it appears for the OPTIONS macro
as used by a customer.
2609133 (1087701)
The Open PL/I Macro Preprocessor's NOTE function now handles all valid built-in functions suitable for
macro usage.
2607126 (1087285)
When the macro preprocessor was making multiple passes on the same portion of code, %ENDFILE
and %FILE were not always generated in Column 1. This was causing issues for the CICS and SQL
preprocessors.
2605895 (1087132)
The output from "NOTE" in PL/I was being incorrectly written to STDERR instead of STDOUT.
STDERR was then causing a loop when you ran it from within the Visual Studio IDE.
2603654 (1086977)
An unterminated quote caused the Open PL/I Macro Preprocessor to loop.
2591348 (1085759)
The Open PL/I Macro Preprocessor would split compound operators when one of the shorthand
operators (+=, *=, -=, or \=) straddled the 255-byte boundary used to word wrap in the macro text. The
macro preprocessor did not recognize them as shorthand operators.
2587494 (1085437)
The Open PL/I Macro Preprocessor now supports ||= statements.
2549371 (1082126)
When you used the PL/I Macro Language PARMSET() built-in, it would sometimes incorrectly report
PARMSET() as true for an argument that had not been passed in. The problem was most prevalent
when a combination of KEYWORD invocation and positional parameter invocations were intermixed
multiple levels deep.
The Open PL/I Macro Preprocessor supports the %OPTION statement.

Open PL/I RTS
Back to the list
•

•

The attributes of FBA 121 are no longer forced into the catalog if no DCB is specified on the file DCL
and no DCB is provided in the JCL DD declaration. Incorrect results occurred when LINESIZE() was
specified on the open. The correct behavior is the LINESIZE value +1 for the CTLASA character.
2662614 (1090784)
A HANG no longer occurs at End of Step when running with full CTF enabled and with SYSPRINT
opened multiple times with one of them using a file VARIABLE. Note that enabling COBOL RTS
#SYSPGM and an undetermined amount of other tracing appeared to bypass this issue in Enterprise
Developer 2.1 Update 1, as did limiting the amount of PL/I tracing.
2662383 (1090814)

Micro Focus Enterprise Developer 2.2 for Eclipse Release Notes

| 63

•

•

•

•
•

•

•
•

•
•

•

•

•
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Previously, the maximum LRECL for VSAM Entry Sequenced datasets was calculated incorrectly to be
four bytes less than the real maximum length.
2662147 (1090749)
Previously, when using a DISPLAY(xxx) REPLY(mystr); syntax, the contents of the DISPLAY statement
were not seen on the console or in the JOBLOG until AFTER the REPLY was satisfied.
2661958 (1090744)
Declaring an ON ENDPAGE for a file in a procedure that drives procedures which attempt to execute a
SIGNAL ENDPAGE (xxx) for the ON ENDPAGE no longer creates a mismatch of the file to the ON
UNIT.
2659472 (1090624)
DSNTIAR now returns an error message if the buffer size is larger than 1000 bytes.
2657101 (1090406)
Previously, if using a COBOL "Main" program to drive PL/I subroutines, the application abended the
second time the COBOL program was executed within the same Batch Initiator.
2649712 (1089898)
Using PUT DATA to a VBA file no longer occasionally results in an incorrect record length creation or
an IO_ERROR_105 occuring. A boundary violation caused by the internally held logical maximum
record length for a STREAM PRINT SYSOUT with DCB overridden to VBA being incorrectly set to the
LRECL rather than physical LRECL was causing the issue.
2649238 (1089582)
Extra blank lines no longer generate erroneously page breaks.
2644985 (1089212)
When executing an application that streams IO to a print file using a LINESIZE > 121, an error would
intermittently occur after ENDPAGE logic triggered within the application and multiple lines of output
were driven as part of a single PUT EDIT statement.
2641134 (1088772)
A problem with using the TRIM built-in with a char(*) parameter of length 0 has been fixed.
2638161 (1088552)
Errors no longer trigger when a PUT DATA() or a PUT LIST() is attempted on a variable of type AREA,
or on a structure containing an element of type AREA, and <...> now signifies the AREA variable
contents.
2618457 (1088918)
Using PUT EDIT statements with a control-format item that specifies a SKIP that triggers an ENDPAGE
condition no longer results in memory corruption if an additional control-format item specified
COLUMN(s) when returning from ENDPAGE and continuing to generate output.
2614479 (1088196)
Writing or rewriting to a record contained in an Open PL/I "Regional(1)" file no longer triggers the
ONKEY condition if a key of 0 was used.
2612112 (1087762)
Accessing PL/I Regional(1) files from an Open PL/I Program no longer triggers an ONKEY condition
when attempting to read KEY(0) from an OPEN PL/I Program. This behavior should have returned 'FF'x
if the record was not present or the actual record if present.

•

2611584 (1087690)
Reading from a PL/I "Regional(1)" dataset into a "CHAR VARYING" field no longer results in garbled
data being returned from a successful read.

•

2611386 (1087674)
When using a VSAM RRDS to emulate PL/I Regional(1) file, a trap no longer occurs if the RECSZ()
parameters for AVG, MAX used to define the VSAM RRDS are identical.
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•

2611383 (1087675)
A compiler issue causing RTS Error 198 during Finalization no longer occurs.

•

2607689 (1087322)
The error message CASSI1745E Error loading MFPLI support (cannot find MPLICPPM) no longer
appears in Console.log when Enterprise Server starts.

•

2605091 (1087696)
If more than 65,535 Open/Close cycles occurred in a long running standalone (.exe) PL/I application,
then an RTS 13 error occured.

•
•

•
•
•
•

2591161 (1085752)
Input/Output speed has increased for PL/I sequential file access.
2589081 (1085599)
Open PL/I now provides support for the generation of ASA Print control characters when writing to files
declared with the STREAM/PRINT Attributes. See the documentation for the rules describing how the
characters are generated.
2527865 (1080288)
An ASRA abend no longer occurs on subsequent access attempts when trying to utilize PLIDUMP in a
CICS Trancode driven in a given SEP.
Previously, when running a PL/I batch program under the control of JCL, if the program generated a call
to PLIDUMP() on Windows, the .dll files were held by the Batch Initiator until it was recycled.
Previously, if using an Open PL/I stream IO within a CICS trancode to drive output to SYSPRINT or
SYSOUT, an abend or memory corruption occurred on the second invocation of the trancode.
RTS Condition 142 is not longer raised when attempting a PUT DATA(); on a variable or structure
containing an OFFSET variable.

Open PL/I SQL Preprocessor
Back to the list
•

Previously, "mfexecpp –sql odbc" included the SQLCA definition twice.

•

2648060 (1089443)
The DB2 preprocessor did not generate database code when an EXEC SQL INCLUDE sqlca was not
defined in application.

•

2641212 (1088770)
A problem with a sporadic incorrect occurence of Error 2000A has been fixed.

•

2606039 (1087150)
The mfdb2 pre-compiler did not tolerate the "BUFFERED" attribute when it was used on a file
declaration.

•

2603472 (1086978)
An ECM for Open PL/1 to translate EXEC DLI statements into the necessary calls to the DLI interface is
now provided.
2578517 (1084612)

RTS
Back to the list
•

•

Using the CBL_EXEC_RUN_UNIT library routine to repeatedly execute non-COBOL processes no
longer causes a 'COBRT105 Memory Allocation Error' error to be produced.
2651531 (1090239)
The library routine C$OSLockInfo now works correctly when used in a program compiled with the
DIALECT(RM) directive.
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•

2643661 (1089044)
The RANDOM intrinsic function, when compiled in a program using the HOSTNUMMOVE directive, no
longer produces a runtime error if the argument is a literal or a numeric expression.

•

2596268 (1086174)
Dynamic memory allocations using the CBL_ALLOC_MEM call are no longer limited to 2Gb on 64-bit
processes.

•

2513886 (1079960)
On Windows, if an error occurs when creating a coredump file, then a message box is no longer
displayed for core_on_error settings greater than 127.

•

•

2509666 (1079870)
Reading from STDIN has been enhanced when STDIN is being redirected from a file or from a pipe line
on UNIX. It now automatically reflects the file type without the need for you to use any runtime tunables.
The record size line sequential files return is now the size of the data that is actually read. The full
record size is now read for record sequential files or when you use CBL_READ_FILE.
2468412 (1075670)
When using the kterm terminal emulator, any new terminal Windows created by COBOL will now be
kterm, in preference to xterm. By default, it will use ShiftJis kanji mode and 16 point fonts but these can
be overridden by setting the COBTERMOPTS environment variable. For example, to use EUC kanji
mode and 14 point fonts, use: export COBTERMOPTS="-fn a14 -fk k14 -km euc"

Samples Browser
Back to the list
•

Enterprise Developer now includes samples for the ACU/RM conversion utility and for XML Extensions
and Xcentrisity.
2600450 (1086612)

Setup Issues
Back to the list
•

•

The Start and Stop scripts for mfcesd and lserv have been improved for handling the possible states
that services and system files may be in.
2657001 (1090384)
Previously, when PLIDUMP was created under Enterprise Server, some of the information was missing
because of a missing message file in $COBDIR/lib. This message file is now also available in
$COBDIR/lang/default so that it can be found and used when creating PLIDUMP files on deployment
platforms.
2615412 (1088915)

Setup Issues (UNIX)
Back to the list
•

startmfcesd.sh has been updated and no longer includes /tmp/mfcesclient* which it starts up. for i in
`ls /tmp/mfcesclient* 2>/dev/null` do rm -rf $i done If no files are present, remove command is skipped.
2657021 (1090386)

SQL: DB2 ECM
Back to the list
•

66

A required file for the DB2(GEN-SQLCA)directive was missing, causing the directive to work improperly.
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•

2659056 (1090501)
The DB2 pre-compiler now saves or restores the RETURN-CODE special register so executing EXEC
SQL statements no longer affects that register.

•

2655173 (1090353)
Previously, the DB2 preprocessor sometimes incorrectly defined the number of host variables to use for
a singleton SELECT when a group host variable was redefined using FILLER.

•

2613602 (1088069)
Previously, the DB2 preprocessor would not generate calls to a system program unless it was linked in.

•

2611937 (1087736)
Previously, the DB2 preprocessor might incorrectly flag indicator arrays as invalid.
2546456 (1088155)

SQL: HCO for SQL Server
Back to the list
•

•
•

•

•

•

•

•
•

Previously, the SPD Generator tool could generate invalid COBOL parameter names if no parameter
name was pecified and the parameter type was DECIMAL.
2664672 (1091009)
Some thread safety issues that occurred in SQL run-time allocation under load have been resolved.
2658581 (1090459)
The performance of forward-only, read-only cursors in SQL CLR stored procedures has been improved
and a new Compiler directive, SQL(OPTION=OPTIMIZESPCURSORS), has been added to provide
additional control.
2644905 (1089182)
When SQL(DETECTDATE) is used with SQL(DIALECT=MAINFRAME), and the mainframe time format
is ISO, the second component of the time value must be present. This is to avoid ambiguity and
unwanted conversion of simple numeric character strings.
2641203 (1090111)
Under HCOSS, SQL error messages returned from calls to DSNTIAR did not always get translated to
EBCDIC when executing the application in that mode.
2615782 (1088148)
There are new directives, SQL(OPTION=SQCLRTRANS) and
SQL(OPTION=SPCOMMITONRETURN), that resolve some issues with stored procedures that expect
COMMIT and ROLLBACK to behave the same as mainframe DB2.
2611786 (1087718)
You can now use DISPLAY statements with COBOL stored procedures for diagnostics in the same way
as with applications, when you set the SQL(OPTION=SPDISPLAY) directive.
2598617 (1086941)
Previously, after a FETCH NEXT ROWSET statement, the number of rows returned was incorrectly
reported in SQLERRD(3).
Dynamic SQL statements executed by EXEC SQL EXECUTE IMMEDIATE are now correctly converted
to T-SQL when the SQL(DIALECT=MAINFRAME) directive is set.

SQL: OpenESQL
Back to the list
•

Previously, the OpenESQL runtime did not work correctly with the unixODBC 2.3.1 and later ODBC
Driver Managers on AIX platforms.
2658290 (1090583)
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•

Using a java.math.BigDecimal host variable as an input parameter to SQL statements caused an
ORA-17041 error.

•

2652362 (1089847)
Previously, when using OpenESQL for ADO.NET, an SQL-CODE error occured when a query timeout
was set from a host variable.

•

2650030 (1089675)
Previously, OpenESQL threw an exception while attempting to set a default JDBC login timeout at
connect time.

•

2647801 (1089421)
When using the Progress Oracle ODBC driver, the OpenESQL runtime incorrectly reported a failure for
a successful INSERT when a successful INSERT was followed by a failing INSERT.

•

•

2646958 (1089336)
OpenESQL now accepts EXEC SQL DECLARE x STATEMENT END-EXEC statements, where x is a
dynamic SQL statement name. This statement has no effect but is accepted for compatibility with other
ESQL SQL dialects.
2643884 (1089076)
When using SQL Native Client or SQL Server Native Client ODBC drivers, the PIC N(xx) USAGE
NATIONAL host variable caused an error when used with the NVARCHAR(MAX) SQL Server data
type.

•

2601192 (1087619)
When executing code compiled for the JVM, if the run-time system encounters a duplicate symbol, it
now reports an RTS119 error, "the symbol is not unique".

•

2598694 (1086469)
Previously, the precompiler incorrectly reset run time information in large Object-Oriented applications
that had SQL statements across multiple methods which resulted in incorrect SQL runtime errors.

•

2597319 (1086681)
When compiling Oracle applications and using SQL(CHECK), errors were reported for SELECT
statements only. This has been corrected to report errors for all statements.

•
•

2566933 (1083631)
You no longer receive an internal buffer error message when compiling OpenESQL applications under
an MBCS UTF8 locale.
EXEC SQL DESCRIBE or PREPARE INTO now return the correct sqltype for VARCHAR columns
when the SQL(OPTION=DESCRIBEVARCHAR) directive is used. The SQL(DATE) and SQL(TIME)
directives now apply to date and time host variables that are declared with SQL TYPE as well as with
PIC X.

Vision File System
Back to the list
•

RMFM now correctly generates 04,05 (and 04,06) statuses and the file status variable contains 04.

XML Extensions
Back to the list
•
•

68

A compiler error when processing XML extensions with dialect(rm) set has been fixed.
2589841 (1085641)
Previously, in native code, XML Extensions treated negative literals (such as in the value of a name/
value pair for XML SET XSL-PARAMETERS) specified as parameters in native code as a large positive
literal. It now correctly treats them as negative literals.
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XML syntax support runtime
Back to the list
•

Block comments in XML instance documents no longer cause a 201 parsing error.

•

2618943 (1088554)
The XML preprocessor now generates correct output for the COUNT IN clause.
2596137 (1086285)

Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:
•
•
•

The WebSync service, where you can download fixes and documentation updates.
The Knowledge Base, a large collection of product tips and workarounds.
Examples and Utilities, including demos and additional product documentation.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page.
Note: Some information may be available only to customers who have maintenance agreements.
If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.
•
•
•
•
•
•

The name and version number of all products that you think might be causing a problem.
Your computer make and model.
Your operating system version number and details of any networking software you are using.
The amount of memory in your computer.
The relevant page reference or section in the documentation.
Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) a tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.
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On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.
To run mfsupport:
1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.
This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.
Note:
If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.
If COBDIR is set to a location that does not contain etc/cobver or COBDIR is not set, mfsupport
gives you the option to search your machine for possible product locations. Note that the search can
take some time if you have a large amount of disc storage and files.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.

Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.
Micro Focus is a registered trademark.
Copyright © Micro Focus 1984-2014. All rights reserved.
This product includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/)".
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